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Scanner Data Manager Section 1

Section 1—Getting Started

Scanner® Data Manager software allows users to view, print, convert, and export data generated by Cameron’s Scan-
ner flow computers for quick review in the field or in-depth analysis in the office. The software also contains tools for
presenting data in a professional customized report. Scanner Data Manager opens the proprietary .sdf and .scm archive
files created by Cameron software products such as ModWorX™ Pro and ScanWin®. Scanner Data Manager supports
Scanner models 3100, 2200, 2100, 2000, 1141, 1140, and 1131.

Installation

Verify that the computer on which the software is being installed meets the following requirements:

Table 1.1—Installation Requirements

System Parameter Requirement(s)
Operating System Windows 7 or later
Computer/Processor 1 GHz or faster 32-bit (x86) or 64-bit (x64) processor
Memory 1 GB RAM (32-bit) or 2 GB RAM (64-bit)
Hard Disk Space 100 MB for program files, adequate space for data files
Display DirectX 9 graphics device with WDDM 1.0 or later driver
Important Before attempting to install Scanner Data Manager software, ensure that you have local adminis-

trator rights to the computer on which the software is to be installed. If the installation is blocked,
contact your Information Technology department for assistance.

To install the software, perform the following steps:

1. Visit Cameron’s Measurement website at http://www.c-a-m.com/flowcomputers, sclect CAMERON Flow Computer
Scanner 3100, and click on the link for the Scanner Data Manager install. A zip file will be downloaded to your
laptop or PC.

2. Unzip the installation folder.

Open the unzipped installation folder and click the “setup.exe” file to begin installation.

When the installation is complete, a Scanner Data Manager desktop shortcut will appear on the desktop (Figure 1.1).

V N

cam

&

Scanner
Data
Manager

Figure 1.1—Scanner Data Manager desktop shortcut

Computer Display Resolution

For best viewing, configure your computer display with a resolution of 1024 x 768 or higher. If a lower resolution is
used, portions of the Scanner Data Manager interface may be hidden from view.

Navigating the Software

This section provides an overview of the Scanner Data Manager software tools and screens. For step-by-step instruc-
tions, see Section 2—Viewing Data Files, page 11, through Section 5—Converting Data, page 57.
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Viewing Tabular Data

A tabular display allows the user to quickly locate and review specific data. Data are grouped logically into measure-
ment data and log types, such as Interval History, Daily History, Triggered History, Snapshot, Alarms, Events, Configu-
ration, Calibrations, User Changes* and Log. Within these groupings, log data are displayed chronologically. Log data
can be filtered or sorted by time and date ranges and printed. Event, alarm, and user change logs can be filtered by data
such as flow run, type of event or alarm, user change, and user login, as well as by month/day or date range. See Data
Filtering by Date, page 13, and Data Filtering of Event, Alarm, and User Change Logs, page 14, for details.

*Note  The User Changes tab, which shows calibrations and user-initiated changes, only appears when viewing ar-
chive files for Scanner 11xx devices. User changes appear on the Events tabs for Scanner 2x00 and Scanner
3100 devices.

Note Data types represented by tabs along the top of the screen will vary with the device used to generate the data

and the data types included in a download.

The Log tab allows the user to view data parsing details and search for user-specified information.

When a file contains log data for multiple flow runs and/or slave devices**, the data are grouped by flow run or slave
device in tabs at the bottom of the screen, as shown in Figure 1.2.

**Note Only Scanner 3100 archive files contain slave device data (for up to 20 slave devices) in addition to two integral
flow runs.

n 53100_Complete.sdf - Scanner Data Manager

Figure 1.2—Muiltiple flow run tabs

Eile Options Help
N W
& 53100_Complete,sdf X
DeviceMeater Name: $3100 Downloaded on:  2015-10-21 12:59:41 .
; ’ Click here to
Company Name: . hid
Site/Well Nare: Device Type: $3100-61 view or hide
Field/Lease Name: Firmware: 1.228 additional
Location Name: Board ID: 0 information.
Legal Desaription: Device SN: 6291470
[ Export Data .] Interval History | Daily History | Configuration | Snapshot | Alarms | Events | Calibrations | Log
Filter?
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00: this
Email Archive File 14 2000-01-09 09:00:00 I 0.000 0.000 0.000 0.000 0.0000 55.687
13 2000-01-09 08:00:00 I column 0.000 0.000 0.000 0.000 0.0000 55.683
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longer to load and S 2000-01-09 04:00:00 I below. 0.000 0.000 0.000 0.000 0.0000 65.696
does not show record 8  2000-01-09 03:00:00 I 0.000 0.000 0.000 0.000 0.0000 55.697
values i
2000-01-09 02:00:00 0.000 0.000 0.000 0.000 00000 54294 |
§  2000-01-09 01:00:00 I 0,000 0,000 0,000 0,000 0.0000 15,556
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[ 4 7000-01-08 23:00:00 T n.n0n 0.000 n.000 0.000 0.0000 15.556 -
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Status Flag - Current selected dateftime
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Click on the double-chevron icon (identified in Figure 1.2, page 6) on the top far right of the data screen to view de-
vice-specific data, such as device name, device location, firmware version, download date and time, etc. Click again to
hide the information and display more data.

The number of visible records is displayed for Interval History, Daily History, Alarms, and Events. The display is locat-
ed under “Sort Order” in the area immediately below the tabs, as shown in Figure 1.2, page 6. Visible records is not

an indication of the total records downloaded. The “visible records” count reflects only those records selected for dis-
play and is dependent on the filters applied.

Viewing Trend Logs

Users can also view measurement data in a full-color graph or “trend” view. Users can zoom in and out, scroll data, and
control the range of the data to be displayed. For further explanation, see Viewing Logs as Trend Graphs, page 16.

Viewing a Snapshot Report

A snapshot report, available on the Snapshot tab, captures flow run and calculated data for a specified point in time for
auditing purposes. Users can view, export, or email a snapshot report to others. See Viewing a Snapshot Report, page
26, for details.

Exporting and Emailing Archive Files

Tabular data can be exported to Excel (.xIsx), comma-delimited (.csv), Internet (html), portable data file (.pdf), and doc-
ument/rich-text (.rtf) formats. Trend data can also be exported as a non-editable image to .pdf, .rtf, .bmp, .jpg, and .gif
formats. If the exported tabular data is to be emailed, Scanner Data Manager will automatically attach export files to

an email file, ready for addressing to a recipient. See Exporting Tabular Data, page 29, Emailing Tabular Data, page

33, and Exporting Trend Data, page 38, for details.

Printing a Report

Scanner Data Manager reporting capabilities are highly customizable. Users can print any individual log type as a sim-
ple spreadsheet or construct a detailed professional report using the embedded customization tools. See Section 4—
Generating Reports, page 41, for details.

Converting Data

Scanner Data Manager allows users to convert Scanner archive files into third-party PGAS™ and Flow-Cal® software
formats. See Section 5—Converting Data, page 57 for details.

Customizing the Interface

Changing Viewing and Export Settings

The Scanner Data Manager interface can be customized to suit individual preferences and save users time in perform-
ing repetitive tasks. For a complete list of configurable viewing options, click Options>Viewing Options.

From this dialog, users can perform the following changes to general settings (Figure 1.3, page 8):
e Change the location where archive files are stored.

e Change export options, such as configuring .csv file exports to use quotes as a delimiter and configuring export
files to automatically open when they are saved.

e Change Scanner 11xx and Scanner 2x00 default unit type to US Customary Units or SI Units.

¢  Change the timestamp convention. By default, timestamps mark the end date/time for each record, which is a
known value generated by the Scanner. When the history timestamps setting is changed to “Calculated Begin Date/
Time,” timestamps will mark the beginning date/time for each record, which is calculated in accordance with the
previous record or interval period, and the column heading will change from “Timestamp” to “Begin Timestamp.”
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¢ Change the number of calibrations/verifications presented in a report and the sort order used to present the data

(Only available when viewing Scanner 3x00-created data files.)

e it et e ————

Viewing Options

-/ General| General
i~ Scanner 3x00
I l.hilsm Open Dialog - Default Data Directory Unit Type (1130¢/2x00 Only)
I L ihits l u| Dusa y Units @) ST Units
Sicm Thex History Timestamps
i~ History Settings
L units Export Options Show

@ Generated End Date,Time

[] Use quote character (7) as a delimiter in CSV fle exports © Cakalated Begin Date Time

[7] Automatically Open Exported File After Save

Note:
Default Exports Directory
[ce\Cameron Data\SOMEPORTS Q| ||| e

 based upon p
records, or in the case of first record the interval period
Calibration Reporting Options (3x00 Only) T

[¥] ndude multiple calibrations verifications
Show current + lo—: previous calibrations S;; ;:urrm

Show current + | 1 7| previous venfications () Type

[] Hide Previous Factory Calb Not Stored Verifi

Figure 1.3—Viewing Options screen, General Settings dialog

Changing Measurement Units

To change unit settings or decimal values, click Options>Viewing Options and click the Scanner device in use in the
menu at the left side of the dialog. Settings vary with Scanner devices. Examples of each set of device settings are pro-
vided in Appendix A—Changing Measurement Units, page A-1.

Changing Trend Views

The trend view (Figure 1.4, page 9) shows the file data as a trend graph, rather than a table. This provides you with
a powerful presentation tool. The trend log can be used with default settings or customized from the Trending Options
dialog. For further information, see Customizing the Trend Graph View, page 17.
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& View Trends

Log Trends

‘ Print Trend ‘ | Export '| | Dane |

[ Enable Al | [ Diable sl | 14 4 » w

Right click scale to

‘ Set Time Axis Range ‘ I Zoom Out Time Axis ] ‘ Zoom In Time Axis | | Reset Time Axis lly adjust values

[P= i:'g:;r'p |"l;§_m_umww IR siatic Pressure (G) (PSIG)
Log Record No. 6113

] 7

M Fow Run 1 MassTosl 0,000 LBM ol

B Flow Run 1 Energy Total 0,000 MMETU Q

M Differential Pressure 0.000 In H2O gz

[ Static Pressure (G} £90,026 PSIG i

[ Process Temperature 72731 Deg F v

-] 7

[ ] 1]

o L4

W Test Oil Flow Time 0.000 sec "

a] 7

L] T~
Wisible Axis

Inner Right Axis

Note: Unused )
Left Axis follows Middle Right Axds
parameter selection

Unused
Outer Right Axis

Unused

Figure 1.4—Log Trends View

Changing Logging Level

The logging level is the level of detail reported while the archive file (.sdf) is being parsed and applies to data conver-
sion as well as viewing and reporting functions. The default setting “Above+Basic Conversion” includes all errors,
warnings, a summary, and basic conversion information, and is recommended for most users.

Note If there are errors, a log file is created and stored at C:\Cameron Data\SDM\Logs.

To change the logging level, choose Options>Logging Level (Figure 1.5) and select a logging level.

Important

Increasing the logging level increases the time required to open the archive file. Therefore,

the level should be changed only when necessary and should be changed back to the default
level (Above+Basic Conversion) before exiting the program. “Above+Detailed Tracking” and
“Above+tinternal Details” logging levels are for troubleshooting only and should only be used by
experienced technicians.

Options

Viewing Options
Trending Options
|@~ Conversion Options

Custom Report Options

Logging Level 3 QOnly Errors

Above + Warnings/Summary
@ Above + Basic Conversion

Above + Conversion Details

Above + Detailed Tracking

Above + Internal Details

Figure 1.5—Options>Logging Level>logging level selections
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“Only Errors” and “Above+Warnings/Summary” are basic logs used to track errors and warnings without logging other
archive data from the flow computer data file. “Above+Conversion Details” provides additional information regarding
conversion calculations.

Changing Logging Levels On-the-Fly

To shorten data parsing time or to change the level of detail in the parsed log, the logging level can be changed on-the-
fly during data parsing using the following steps:

1. Click the Pause button (Figure 1.6) on the Log tab to freeze the current parsing log.

Note The Pause button only appears during data parsing. Once the parsing log has been paused, the “Pause” label
changes to “Continue.”

Log
I® Canoal‘ “El Pause | " Find

INFO: Parsing file: C:\Cameron\Scanne
INFO: Processing Device 1

INFO: Processing 70 records.

INFO: Parsing Record #1 - 3x00 Config
INFO: Parsing Record #2 - 3x00 Config
INFO: Parsing Record #3 - 3x00 Config
INFO: Parsing Record #4 - 3x00 Snapsh
INFO: Parsing Record #5 - FR #1 3x00
INFO: Parsing Record #6 - FR #2 3x00

INFO: Parsing Record #7 5D #1 3x00

TUEA. Daveicm~ Bom~wa d8 en &9 2wnn

Figure 1.6—Pause button (Log tab)
2. Choose Options>Logging Level and select the new logging level from the menu.

3. Click the Continue button to resume parsing.

Note Only unparsed data will be parsed using the new logging level. To parse the entire file using the new logging
level, you must close and reopen the archive file.

10
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Section 2—Viewing Data Files

Scanner Data Manager can be used to view any .sdf or .scm files download from a Scanner flow computer. To open a
file, select File>Open (Figure 2.1) and navigate to the file’s location. The four most-recently accessed files are listed at
the bottom of the File menu for quick access.

Eiie| Options  Help
3 Open

LB Batch Conversion
Cloze
Close All Files
1 CACameron Data\SDMSlave0l_S401 T Full.sdf
2 CACameron Data\SDMY53100_Local.sdf
3 CACameron Data\SDMY53100_FA01 T Full.sdf
4 C\Cameron Data\SDMY53100_Complete, sdf

H Exit

Figure 2.1—File menu

File contents can be previewed by selecting the file name in the Open Archive dialog (Figure 2.2).

Lookin: ) SDM - @ @ i Archive File Contents
= Mame = Size  Item type Date T‘ée“'i“ﬂ: §§f0§§1
= resator: -
he | EXPORTS File: folder 20| sl 1 oen
Recent ltems . Reports File: folder 1/20| Crezted Cn:
B 396MB  Scanner 2¢00/3:00 4r...  2/20 2015-02-20 l4:36:48
| =% S3100_EA_Full sdf 218MB  Scarner 24004300 AL 2416 Cpees -
' =¥ 53100_FANT_|_Full sdf 1.68MB  Scanner 2¢00/3:00 4r...  2/20 6 e
Desktop «® 53100_Local sdf E19ME  Scanner 2400/3004r . 2116  Tnoerval Logs
) =4 Slavell_SA07_|_Full sdf 49KB  Scanner Zx00/3=00 Ar.. 2420 Triggered Logs
{; Alarm Logs
| Event Logs
My Documents Configuration (Full)
Archive Configuration
“' Snapshot
A
CHU1471972
@ 4| il | 3
Network  Filename:  S3100_Complete.sdf
Files of type: [AII Scanner Archive Files [*.gom;® 2df) v] [ Cancel ]

Figure 2.2—Open Archive dialog showing file contents on the right of the screen

The software will parse the data records and display the log in the main screen. The presentation of the archive data
will vary, depending on the Scanner flow computer model in use and the type of data downloaded.

Multiple files can be open at a time. Each opened file will appear as a separate tab at the top of the tabular view (Figure
2.3, page 12). To exit data files, choose Close to exit a single file or Close All Files to close all open files simultane-
ously (Figure 2.1).

1
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Default Viewing Settings
Upon installation, Scanner Data Manager will function in accordance with the following default settings:

*  When the user selects File>Open to select an archive file (.sdf or .scm), Scanner Data Manager displays the con-
tents of the “C:\Cameron Data” directory.

*  The log type included in the data export is based on the tab selected at the time.

Note When exporting data to Flow-Cal or PGAS format, all log types are included in the exported file.

e Tabular data files are exported to the file format selected from the Export Data dropdown menu.
e The log trend view displays logs “By Records” by default.
e The interval trend view displays 24 hourly records, and the daily trend view displays 30 records by default.

Viewing Logs as Tabular Data

The poll date, Scanner firmware version, and filepath for the archive file are published at the top of the screen. The vari-
ous log types (Hourly or Interval History, Daily History, Snapshot, Alarms, Events, etc.) and device settings (Configu-
ration, Calibrations, etc.) are identified in tabs across the top of the screen (Figure 2.3). If a download file contains data
for more than one flow run and/or data for slave devices, data will be grouped by flow run and displayed in separate
tabs at the bottom of the screen.

Note Scanner 3100 archive files may contain up to 20 slave devices in addition to two integral flow runs.

| @ 53100_Complete.sdf - Scanner Data Manager i

File Options Help
N

& 53100_Complete sdf X "@ Slave01_SAD1_1_Full.sdf x| & 53100_Local sdf "@ 53100_FAD1_I_Full.sdf X ” & s3100_Ea_Full.sdf X|<_ Each File Opens in a Separate Tab

| Device/Meter Name: Downloaded on:  2015-02-20 14:36:48 ‘|
{ Export Data v} Interval History | Daily History | Configuration | Snapshot | Alarms | Events | Calibrations | Log [<@—— Logs Displayed by Data Type
® Fiter by Month/Day [oneselecied 7| | StartDate [1/5/2000 7:00:00PM
Filter by Date Range End Date [1/3/2000 11:00:00 PM
= Mumber of Visible Records: 29
Trending A Change to Trend View Flow Run 1 Gas [Flow Run 1 Gas [Flow Run 1 Gas |Flow Run 1 Run F"”s""h“t‘_"c" 1 | FlowRun1 ;ﬁ‘: =
Rec Timestamp Status Flags Volume Total Mass Total Energy Total Time Pressure Temperature Pre
m3 ka M1 3 KkPa(g) = i
2000-01-09 23:00:00
©) By DatefTime = 27 2000-01-09 22:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.658
26 2000-01-09 21:00:00 EI 0.000 0.000 0.000 0.000 0.0000 65.696
25 2000-01-09 20:00:00 I H h 2 0.000 0.000 0.000 0.000 0.0000 65.625 |
24 2000-01-09 13:00:00 I 0.000 0.000 0.000 0.000 0.0000 65,650
23 2000-01-09 18:00:00 1 0.000 0.000 0.000 0.000 0.0000 65.683
22 2000-01-09 17:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.682
;a\’;':j";""r‘f;'t":;:: by 21 2000-01-09 1&:00:00 I 0.000 0,000 0.000 0.000 0.0000 65,682
longer to load and 20 2000-01-09 15:00:00 1 0.000 0.000 0.000 0.000 0.0000 65.683
Sgﬁf&"“ show record 19 2000-01-09 14:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.683
18 2000-01-09 13:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.683 B
17 2000-01-09 12:00:00 1 0.000 0.000 0.000 0.000 0.0000 65.684
16 2000-01-09 1L:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.685
15 2000-01-09 10:00:00 I 0.000 0.000 0.000 0.000 0.0000 65,686
14 2000-01-09 08:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.687
13 2000-01-09 08:00:00 I 0.000 0,000 0.000 0.000 0.0000 65.688
12 2000-01-09 07:00:00 1 0.000 0.000 0.000 0.000 0.0000 £5.650
Flow Runs and 11 2000-01-09 08:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.652
Slave Devices* 10 2000-01-09 05:00:00 I 0,000 0,000 0,000 0,000 0.0000 65,694 pr
Displayed < ] | »
in Separate Tabs Status Flag - Current selected date/time
(*Only Scanner 3100 p - Partial E - User Events 0 - FR1 Input Dverride S -FR1 5P Alarm 0 - FR2 Input Overide 5 - FR2 5P Alam
archive data & - Estimate F - Flowrun Alams * - FR1 Input Failure [ - FR1 DF &laim % - FR2 Input Failure d - FRZ DF Alam b - Memory Fault
’“aV;':/'i‘;‘;:j'a"e T - Triggered Record I - Input Alarms U - FR1 LA Alam H - FF1 Cale Change u- FRZ LA Alam h - FR2 Cale Change W -watchDog Fieset
T-FR1PT Alaim C - FA1 Calc Error t-FRZ PT Alaim © - FR2 Calc Enor R - Power On Reset
FR#1 4 FR #2 4 Slave #1

Figure 2.3—Main screen
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Sort Order

By default, data logs will appear in the order in which they are downloaded, top to bottom. However, the user can sort
data by date/time stamp or record number by changing the selection in the Sort Order dropdown menu (Figure 2.4).
Each sort order selection is specific to the log type (tab) selected when the sort order is designated.

Sort Orger
53100_Complete.sdf (V] Fiter?
< S Default (As downloaded - o
Eile Options Help - : e (@ Fiter by Month/Day | None selected
W M= | Date/Time - Earliest First Fiter by Dote Range |~ pEcerer
& 53100_Complete.sdf _NW‘WN 53100_Local.sdf X% ||@ 53100_FAD1_I_Full.sdf ||0 53100_EA | L
Record Number - Ascending
Record Number - vice Meter Name: Downloaded on: 2015
[ Export Data v} Interval History |Daily"istory | Configuration | Snapshot | Alarms | Events | Calibrations | Log
Filter?
ik Sort OrdErI Date/Time - Latest First - I O
Print Interval History = (@ Filter by Month/Day  |MNone selected StartDate |1/8/2000 7:00:00 PM
ﬁ End Date |1/2/2000 11:00:00 PM
Custom Reports Filter by Date Range
Number of Visible Records: 29 -
-
Trending Flow Run 1 Gas [Flow Run 1 Gas |Flow Run 1 Gas|Flow Run 1 Run Fh;"t::'_': L Flow Run 1 ;l:'“
Rec Timestamp Status Flags Volume Total Mass Total Energy Total Time P are Temperature Pr:
View Trend m? Ml s B
N 5 o
@ By Records 2000-01-09 23:00:00 7 Fiter? ||
©) By Date/Time * 27 2000-01-09 22:00:00 I
2 2000-01-08 21:00:00 EI her by MnkDay o Start Date ORI M e
.00: 4(25/2014 5:25:00 PM
Email Archive File 25 2000-01-0% 20:00:00 I H @ Filter by Date Range End Date
24 2000-01-09 19:00:00 I Al April b 42014 »
23 2000-01-09 18:00:00 1 SN TW TIFS
22 2000-01-09 17:00:00 I ]; 3; ; : 1: 14 1:
~ Uiz Ty 21 2000-01-09 16:00:00 1 -
Date/Time takes 1314 15 16 17 18 19
longer to load and 20 2000-01-09 15:00:00 I ERER i o5
does not show record 19 2000-01-09 14:00:00 1 B3B3 123
values 45678310
13 2000-01-09 13:00:00 I
17 2000-01-09 12:00:00 I
16 2000-01-09 11:00:00 I g 2 a o o a
15 2000-01-09 10:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.686
14 2000-01-09 09:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.687
13 2000-01-09 08:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.688
12 2000-01-09 07:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.650
11 2000-01-0% 06:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.692
10 2000-01-09 05:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.694 )
4 il | 3
Status Flag - Current selected dateftime
p - Partial E - User Events 0 - FRT Input Owerride S -FR1 SP &larm o - FRZ Input Dverride 5 - FR2 5P &lam
e - Estimate F - Flowsiun Alarms # - FR1 Input Falure [ -FR1 DP Alaim - FR2 Input Failure d-FR2DF Alarm M - Memory Fault
T - Triggered Record I - Input Alarms U - FR1 UA Alarm H - FR1 Cale Change u-FR2 UA& Alarm h - FR2 Calc Change: W - WatchDog Reset
T -FR1PT Alam C - FRT Cale Emor t-FRZPT Alarm c-FRZ Calc Emor F - Power On Reset
g1 ez e |

Figure 2.4—Sorting and data filtering functions

Data Filtering by Date

Log data is easily filtered by checking the “Filter” area and selecting one of the following filtering options, as shown in

Figure 2.4:

*  Filter by Month/Day—A dropdown menu will list all dates (by month and by day) for which data is stored. The
user can select multiple dates or months by clicking in the checkbox next to each desired selection.

*  Filter by Date Range—To initiate a filter, click the dropdown arrow next to the “Start Date/End Date” field to
display a calendar dialog, select the desired start and end date/time, and click OK.

Note  When timestamps are configured to mark the end date/time (default setting) and data is filtered by month, the
first day of the month following the “filter month” is automatically included in the filter range. This is because
data stored on the last day of the month is downloaded at the contract hour of the following day. For example,
when a user filters data from July, the download from August 1 is included. This download includes data stored
during the 24 hours between the July 31 contract hour and the August 1 contract hour.
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Data Filtering of Event, Alarm, and User Change Logs

Event, alarm, and user change logs can be filtered by columnar data such as flow run, type of event, alarm, or user
change, and login ID, as well as by the standard month/day or date range filters.

Events can also be filtered by “Group” or “Key.” Group is the type of parameter associated with the event, and Key
specifies the exact parameter associated with the event (which is required when the device supports multiple configura-
tions within a function (for example, a Group selection of Digital Output and a Key selection of 2 will cause the spread-
sheet to filter data for Digital Output 2).

Note Columns that can be filtered have a gray down arrow to the right of the column heading (Figure 2.5).

To filter by column,

1. Click on the appropriate tab (event, alarm, or user changes).
2. Click on the gray down arrow to the right of the column heading.
3. Select the desired filter type from the dropdown menu, as shown in Figure 2.5. The data will be organized by the

filter type selected.

R

& 53100_Complete sdf 3 H@ 53100 FAOL I Full.sdf H@ Slave01_SAD1_1 20151023, 5df 2 ||@ Slave01 SA01 D Full.sdf x|

‘ ‘ DeviceMeter Name: 53100 Downloaded on:  2015-10-23 13:27:11 ||
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Filter by Date Range End Date [10/23/2015 1:22:00PM_ ~
Number of Visible Records: 38
p—
Trending Rec Timestamp Group - | Key - Event Type ['l Data Ttem 0Old Value - Hew ¥V
Ve Tr 015-10 00 0 A og
123 2015-10-23 13:101:42 0 (Custom...) Log Out
@ By Records 122 2015-10-23 11:21:25 0 Configuration Lock Click on the LogIn
By Date/Time = 21 2015102301521 0 :Z:::‘:nrt dropdown arrow Login Expired
119 20151022 13:52:18 Slave Device | User Change Event to the right of the 0x00000002 0x00000000
120 2015-10-22 13:52: 15 Slave Device 1 Eer Change Ever column headlng and 11 0
117 2015-10-22 13:51:54 0 Login Event select a filter from Login Disconnected
118 2015-10-22 13:51:54 0 Login Event the dropdown menu. Log In
114 2015-10-22 13:50:22 ] Login Event Log In
* Viewing Trends by 98 2015-10-22 13:49:27 0 Configuration Lock Lock Enabled
Date/Time takes -
longer to load and a3 2015-10-22 13:39:25 a Login Event Log Out
does not show record a9 2015-10-22 13:39:17 Slave Device 1 User Change Event  Slave Device #1: Mode 0x00000000 0x00000002
values a0 2015-10-22 13:39:17 Slave Device il User Change Event  Slave Device #1: Slave Address 1] 11
91 2015-10-22 13:39:17 Slave Device 1 Uger Change Event  Slave Device #1: Port Baud a 38400
&6 2015-10-22 13:39:02 Serial Port LE i User Change Event  Serial Port LE #1: End Point 3 11
a7 2015-10-22 13:39:02 Modbus Enron 1 User Change Event  Modbus Enron #1; Upper Port 1 1]
88 2015-10-22 13:3%:02 Wired Manager il User Change Event  Wired Manager #1: Upper Port 1] il
35 2015-10-22 13:38:37 a Login Event Log In
67 2015-10-22 13:36:59 1] Configuration Lock Lock Enabled
45 2015-10-22 13:36:26 1] Configuration Lock Lock Enabled
42 2015-10-22 11:11:59 ] Login Event Log In
41 2015-10-22 09:26:29 a Login Event Log Out
40 2015-10-22 09:26:13 a Login Event Log In
3’ 2015-10-22 09:26:06 ] Login Event Log Out
38 2015-10-22 09:25:41 ] Login Event Log In
37 2015-10-22 08:48:38 a Configuration Lock Lock Enabled
36 2015-10-22 08:48:37 1] Configuration Lock Lock Disabled
ac ANAE.1777 AE.EA.77 n Lnwin Fusnt Lnrim Fvrirad
4] [ ] S
L —

Figure 2.5—Event tab showing dropdown arrows

To remove alarm, event, and user change data filters, click the Remove All Filters button, which is located near the top
of the screen when the Events, Alarms, or User Changes tabs are selected (see Figure 2.6, page 15).
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@ 53100_Complete,sdf 3¢ " @ S3100_FAD1 I Full.sdf 2 ” @ Slave01 SA01 I 20151023,sdf 2 ” @ SlaveD1 SA01_D_Full.sdf 2C |
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Interval History | Daily History | Configuration | Snapshot || Alarms | Events |calibrations || Log |

: Filter by Date Range
Number of Visible Records: 38
Trending Rec Timestamp Group Key - Event Type [vl Data Ttem
T o Geon
@) By Records TE R A 8 Configuration Lock
By Date/Time = 121 2015-10-23 01:52:16 0 FIP Server
ogin Event
119 2015-10-22 13:52:18 Slave Device 1 User Change Event
120 2015-10-22 13:52:18 Slave Device 1 ser Change Even
117 2015-10-22 13:51:54 1] Login Event
113 2015-10-22 13:51:54 a Login Event
114 2015-10-22 13:50:22 1] Login Event
* Viewing Trends by 95 2015-10-22 13:49:27 0 Configuration Lock
Date/Time takes N
longer to load and a3 2015-10-22 13:39:25 1] Login Event
does not show record &9 2015-10-22 13:39:17 Slave Device 1 User Change Event  Slave Device #1: Mode
palies a0 2015-10-22 13:39:17 Slave Device 1 User Change Event  Slave Device #1: Slave Addres
91 2015-10-22 13:39:17 Slave Device 1 User Change Event  Slave Device #1: Port Baud
86 2015-10-22 13:39:02 Serial Port LE 1 User Change Event  Serial Port LE #1: End Point
a7 2015-10-22 13:39:02 Madbus Enron 1 User Change Event  Madbus Enron #1: Upper Port
&8 2015-10-22 13:39:02 Wired Manager 1 User Change Event  Wired Manager #1: Upper For
85 2015-10-22 13:38:37 1] Login Event
67 2015-10-22 13:36:59 1] Configuration Lock
45 2015-10-22 13:36:26 1] Configuration Lock
42 2015-10-22 11:11:59 1] Login Event
41 2015-10-22 09:26:29 a Login Event
40 2015-10-22 09:26:13 1] Login Event

Figure 2.6—Remove All Filters button

Custom Filtering (Advanced Users)

In addition to the columnar filter checkboxes, users can create a Custom filter to filter data based on specific criteria

within a cell. To add a custom filter,

1. Click the appropriate tab (event, alarm, or user changes).

2.
Custom Filter dialog opens (Figure 2.7).

Custom Filter

Show rows where:
Data Item

! AND

l

I OR

4

Cancel

Pam—c

Click the gray down arrow to the right of the column heading and select (Custom...) from the dropdown list. The

Custom Filter

Po—c=

Show rows where:
Data Item

egquals

does not equal
is less than

ie greater than

like:

not like

iz blank

is not blank

ig less than or equal to

is greater than or equal to

Cancel

Figure 2.7—Custom Filter dialog

3. In the first selection field, click the dropdown arrow and select your criteria. In Figure 2.7, the criteria for the
selection field on the right is “equals.” In the selection field to the right, enter a type, a value, or text. Note the
special characters listed at the bottom of the dialog that can be used as “wild cards” to represent any characters or

numbers.
4,
text in the second row of dropdown menus.
5. Click OK to apply the filter.
6.
heading and select (All).
7.

To add a second criterion, click on the and or or button and enter a new criterion and the associated type, value, or

To clear the columnar filter without removing a date filter, click the gray down arrow to the right of the column

To remove all filters, date filter included, click the Remove All Filters button (see Figure 2.6).
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Viewing Logs as Trend Graphs

Measurement data trends can be viewed by record number (recommended for continuous logging) or by date/time (rec-
ommended for logs with gaps in data) from the Interval, Daily Logs, Triggered or Data Logger tabs. The trend view
presents the downloaded logs in two graphs (Figure 2.8)—a top graph showing the entire contents of the downloaded
log and a bottom graph showing a user-selected segment of the log.

]

Print Trend | | Export « Done
Log Trends

ydeug doj

| Enable All | | Disable Al | (5 I T S | | Set Time Axis Range | | Zoom Out Time Axis | | Zoom In Time Axis | | Reset Time Axis Rioht (':'Iic:dsiﬁ:lle\.-.;?ugg
[Pasamenes [vahe [ |= ~
Timestamp 2015-10-22 13:37:08 Gah; 1 Water ()

Log Record No. 45
B Flow Run 1 Gas Volme Ti 0,004 MCF
B Flow Run 1 Gas Mass Totz 0,168 lbm
B Flow Run 1 Gas Energy Te 3803,546 Bru
M Flow Run 1 Static Presswre 10,503 psig
=

9
9
@
?
?
m ¥ w
= 9 a
B ? g
o '] 3
. ’ ]
T
? =
m g -
Visible Axis 3 Optional Y Axes
Inner Right Axis
Note: Mass
Left Axis follows Middle Right Axis
parameter selection

Energy

Cuter Right Axis

Gas Volume

Figure 2.8—Log trend view

Top Graph

The top graph provides a high-level view of all data in a log. Click anywhere in the top graph to select the range of re-
cords to be magnified in the large graph display at the bottom of the screen.

Note If the records in a log are too numerous to be displayed in the bottom graph, a gray rectangle will appear on
either side of the top graph. Click and drag the gray rectangle to move the graph and bring hidden records into
view.

Bottom Graph

The bottom graph allows a user to view records in detail. Screen controls allow a user to view multiple parameters on
one graph or isolate selected parameters for viewing. Up to four Y axes can be displayed, maximizing the information
available in a single view.

To view a different data range

*  Use the scroll bar beneath the graph to shift the graph to the left or right.

e  When viewing a trend by record number, advance the graph one record at a time using the right and left arrow but-
tons on the computer keypad or by clicking on the right or left arrow in the scroll bar beneath the graph.
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*  Click the Zoom Out Time Axis button to view more data or Zoom In Time Axis to view data in greater detail.

Customizing the Trend Graph View

To customize the trend graph view, choose Options>Trending Options. The General Trending Options dialog will ap-
pear. From the Trending Options interface, you can choose how trend data is displayed. The options are divided into
one general category and three Scanner-specific categories, as shown in the left column of Figure 2.9.

General Trending Options

The General Trending Options dialog (Figure 2.9) allows users to customize the settings that will serve as a template
for all Scanner trend views.

-_!!snf ing Options

Trending Options

T General Sel_et_:tt_ t:edm: view and set fSoerI::tc:]he;r—:nmdeigf color
Seanner 3x00 up initial data ranges. p: g
i~ Scanner 2x00 —
i Ecanner 11xx Default Initial Range Default Trend Colors Hote:
Trend By Archive Column 1 - -
@) By Record (©) By Date/Time For Scanner 3x00/2x00 files
Archive Column 2 -| - Default i"rend(abrsare_ both
[—I 1 the color and the order in
Initial interval range shown on trend: 24 % | Records which trends are colored as
l I Archive Column 3 -|v a imted with the positi
Initial daily range shown on trend: 30 2 | Records of the archive column it was
Archive Column 4 | - downlosded.
Ranges By Record’ must be in even numbers.
ges in odd bers will be fed up. frame @i -| A For more than 16 columns, the
Archive Column 6 -| - (ST R
Default Axis Settings Archive Column 7 -| -
Set Axis By Archive Column 8 -| -
@ Category (O Parameter P |v
Supported Axis Archive Column 10 -| -
[o=Esidirs Archive Column 11 | -
note:
i . Archive Column 12 -| -
Left Axis follows parameter selection  Middle Right Axis
Archive Column 13 -
See the View Trends dialog to assign |
ight axis parameters for Scanner
g, andm il Outer Right Axis Archive Column 14 -| -
s ok 15

Archive Column 15 | -
Establish axis preferences

and add up to three Y axes.

x| o]

Figure 2.9—General Trending Options dialog
From this dialog, the user can perform the following tasks:
e Select the criteria used to trend data (by record or by date/time, the default).

— When trending by record, ranges must be even numbers from 2 to 100.
— When trending by date/time, choose the number of days in the range (0 to 100).

Note Selecting date/time may cause data to load more slowly and the number of record values will not be displayed
on date/time trend graphs.

e By default, the left Y axis follows the parameter selection. However, the “Default Axis Settings” allow you to
configure the right axes to represent a unit category (volume, mass, temperature) or a parameter. Categories can be
selected selected for up to three right axes in the General Trending Options dialog.

e Setup to three additional right Y axes, which appear as inner right axis, middle right axis, and outer right axis
sequentially. If the inner right axis is changed to “Unused,” all three extra axes will be removed.
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Note The variable represented by the left Y axis is determined by the active parameter selection, which is highlighted
in blue. When selecting other axes to display, verify that the parameter selected appears in the data file and has
a value greater than zero.

e Select trend colors, if desired. Trend colors will be applied to parameters in the order they appear, and will be
repeated as required, depending on the number of items in the archive file.

Note When selecting trend colors, keep in mind that the screen displays logs on a black background. The printed
background will be white. If trends will be printed, select colors that will be visible both on screen and in printed
graphs.

Scanner 3x00 and 2x00 Trend Settings

The model-specific Scanner settings in the left-most section of the Trending Options screen allow users to make addi-
tional choices about how trend data for a specific model is presented. Click the Scanner model in use.

e Select the parameters to appear on the trend graph (Figure 2.10).
e Set the trend graph default units to SI Units or US Customary.
e Customize the data ranges and/or units associated with select unit categories.

e Customize axis settings (override general axis settings).

Trending Options

Trending Options
; Scanner 2x00 Trend Settings

- Trend Settings Category Settings Set Units to Defaults Override Axis Settings
inner 2x00

{ Trend Settings | SIUnits | | US Customary Set fxds By

Scanner 11xx @ Category Parameter
- Trend Settings

Mame Show Auto Min Max Range Units ZI Supported Axis

Trending Options

Tlfending Options
General Scanner 3x00 Trend Settings Apply default unlts.j
Scanner 3x00
. T’E’d;::t"gs Catoruay s S Set Units to Defaults Override Axis Setlings
canner
Trend Settings SI Units US Customary Set Axis By
Scanner 11xx @ Category Parameter
Trend Settngs Name Show Auto Min Max Range Units - Supported Axis
Range Range  Range )
None ) 100 Left Axis
Click in the Uncorrected Gas Volume ) 100 m® ‘SE\Ected Parameter vl
Category Uncorrected Liquid Volume 0 100 m? Inner Right Axis
Settings field Gas Volume 0 100 m? [nused -]
tC_) toggle ﬂ_‘le Liquid Volume 0 100|m= Middle Right Axis
display units Static Pressure (absolute) o 100|Pa ‘Llnused v|
on or off, Static Pressure (gauge) 0 100 kPa(g)
. _ - = 5 Quter Right Axis
establish Differential Pressure 0 100 kPa
minimum and Temperature 0 100 °C ‘unUSEd v|
maximum Mass 0 100 bbm f
; Ei E E 0 100 3
units and the L"enﬂ . B
type of units = m Select axis overrides
in th ey I i for the inner, middle
1) U (I, Resistance 0 100 Ohm e ’ht ’
Current 5 00lA ana outer rignt axes.
Voltage ] 100 my
Fraction 0 100 o

Figure 2.10—Scanner 3x00 and 2x00 Trending Options dialog
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Scanner 11xx Trend Settings

Trend customization options vary with Scanner models. From the leftmost section of the Trending Options screen, click
Scanner 11xx to change trend settings, such as

Select the parameters to appear on the trend graph (Figure 2.11).

Override trend colors.

Customize the data ranges and/or units associated with select unit categories.

Customize axis settings (override general axis settings).

-

ending Op
Trending Options
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Scanner 3x00
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canner 2x00
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. Trend Settings
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SISISISISISISISISISISISISISISISISIS S i
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i

Trend Override Axis Settings
Min  Max Range Units | «| Set Axis By
Range Range ] @) Category
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0 10}1 Left Axis
Z EZ :: |Seleched Parameter A |
0 100 Pa Inner Right Axis
i} 100 |Unused v|
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0 100 K |Unused v|
0 100|RDg Quter Right Axis
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Figure 2.11—Scanner 11xx Trending Options dialog
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Viewing Trends by Record

By default, trends are displayed by record number, which is ideal for continuous logging. To view log trends by record,
click the By Records option in the “Trending” section on the left of the main screen (Figure 2.12, page 20), then
click the View Trends button.
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|| Device Meter Name: Downloaded on:  2015-02-20 14:36:48 ”
[ Export Data v] Interval History | Daily History | Configuration | Snapshot | Alarms | Events | Calibrations | Log |
@ Fiter by MonthDey [Noresdiecmg | | StartDate [1/3/2000 7:00:00 M
- End Date (1/9,/2000 11:00:00 PM -
Mumber of Visible Records: 29 s
Trending Flow Run 1 Gas |Flow Run 1 Gas |Flow Run 1 Gas |Flow Run 1 Run Fh;“ta“h"‘cr:l 1 Flow Run 1 [F’!%"(' =
Rec Timestamp Status Flags Volume Total Mass Total Energy Total Time Temperature
View Trends m3 kg M1 =z Pressure aC Pre|
= kPa(g) |
(@ By Records 000-01-0 0 0.000 000 0.000 0.000 0000 &
() By Date/Time * 2000-01-05 22:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.698
2% 2000-01-05 21:00:00 E I 0.000 0.000 0.000 0.000 0.0000 65.696
25 2000-01-09 20:00:00 E H h ] 0.000 0.000 0.000 0.000 0.0000 65.625
24 2000-01-05 19:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.650
23 2000-0109 18:00:00 1 0.000 0.000 0.000 0.000 0.0000 55.683
2 2000-01-05 17:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.682
E’:ti;“_‘l‘_il"r‘f;":é‘?f by 21 20000109 16:00:00 1 0.000 0.000 0.000 0.000 0.0000 55.682
longer to load and 20 2000-01-09 15:00:00 T 0.000 0.000 0.000 0.000 0.0000 65,683
Sgisa:ut show record 19 2000-01-05 14:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.683
18 2000-01-05 13:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.683
17 2000-01-05 12:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.684
16 2000-01-05 11:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.685
15 2000-01-05 10:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.686
1% 2000-01-05 09:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.687
13 2000-01-05 08:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.688
12 2000-01-05 07:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.650
11 2000-01-05 06:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.692
10 2000-01-05 05:00:00 I 0.000 0.000 0.000 0.000 0.0000 65.694 -2
4| [ | »
Status Flag - Current selected dateftime
p - Partial E - User Events 0 - FR1 Input Override S -FR1 5P Alaim o - FR2 Input Owverride 5 - FR2 5P Alam
& - Estimate F - Flowrn Alarms - FR1 Input Failure [ - FR1 DP Alarm - FR2 Input Failure d-FR2 DP Alarm M - Memary Fault
T - Triggered Recard I - Input Alarms U -FR1 UA alarm H - FR1 Calc Change u-FR2 L& Alarm h - FR2 Cale Change: W - \WatchDiog Reset
T-FR1PT Alam .- FR1 Cale Emor t-FR2PT Alam o - FR2 Calc Emor F - Power On Feset
vyaeyeosy |

Figure 2.12—View Trends "By Records” option

The record values will be plotted in trend lines, as shown in Figure 2.13, page 21.

Note the dotted vertical white line in the bottom graph. This Record Index line remains in a fixed location, and marks
the record highlighted at left. The value range for the highlighted parameter is displayed on the left axis.

In Figure 2.13, page 21, the Record Index line intersects the trend graph at Log Record Number 4879. The log num-
ber, timestamp, and individual parameter values in that log are displayed in the table at the left of the screen. These
numbers and values are automatically updated when the data is scrolled using the scrollbar at the bottom of the screen.
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Figure 2.13—Record Index marker for viewing trends by record

For information on viewing data values for a specific parameter, see Analyzing a Single Trend Line, page 25.

Viewing Trends by Date/Time

For logs that include gaps in flow, users may prefer to view trends by date/time by blocks of time rather than by record
numbers, since gaps may be difficult to identify when viewing by records.

Note Viewing by date/time may result in longer load times for displaying the graph and is only recommended for view-
ing triggered logs or other logs in which a time gap in logging is expected.

To view log trends by date/time, click the By Date/Time option in the “Trending” section on the left of the screen (Fig-
ure 2.14, page 22), then click the View Trends button.

The date/time values will be plotted in trend lines as shown in Figure 2.15, page 22.
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Figure 2.14—Log trends select “by Date/Time”
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Figure 2.15—Log trends displayed by date/time
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Note When viewing trends by date/time, the timestamp and log record number fields are not populated in the param-
eters table and the record values do not appear during scrolling. Instead, date and time intervals appear along
the X axis near the bottom of the screen.

To view data values, select a parameter in the table and click anywhere in the trend graph. A white dotted circle will ap-
pear on the selected trend line and a text box attached to the cursor will display the data value and record date/time for
the selected data point. Move the cursor over the trend graph to see the values change as the cursor locks on to various
data points.

For more information on viewing data values for a specific parameter, see Analyzing a Single Trend Line, page 25.

Choosing Axes

Up to four axes may be used to track data values for parameters or categories. See Viewing Logs as Trend Graphs, page
16 for more information. The left axis is fixed and reflects the active selected parameter. Up to three axes for tracking
other parameters or unit categories are optionally available on the right side of the trend view.

To add right axes, click the “Inner Right Axis,” “Middle Right Axis” and “Outer Right Axis” dropdown menus, respec-
tively, and select the parameter or category to be assigned to each. If you select a parameter/category that is unavailable,
the following message will appear:

- Warning

Selected Inner Right Axis category
is not available for this archive log.

Please select another category.

Figure 2.16—Y axis warning

Adjusting the Data Range

The trend view display contains a number of controls for customizing the display. Adjust the range of data in view us-
ing one of the following methods.

Dates and Times

Click on Set Time Axis Range and enter a Range Start date and time and a Range End date and time using the calen-
dars provided (see Figure 2.17). For daily logs, enter start and end dates only (no times).

Select Date and Time Range ﬂ

Range Start Range End

] March 2003 3 ] March 2003 3
Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat
i 2 % g4 uni i69 5 12 3 4 5 6 7
8 9 10 11 12 13 14 8 9 10 11 12 13 14
15 16 17 18 19 20 21 15 16 17 18 19 20 21
2 23 24 25 s 2 2325 5 v
9 30 3 1 2 3 4 9 30 31 2 03 4

08:00:00 AM [~ 08:00:00 AM |~

Figure 2.17—Select Date and Time Range dialog

Enlarge or narrow the time axis by clicking Zoom Out Time Axis or Zoom In Time Axis (Figure 2.15, page 22).
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Data Values

The range of values shown on a Y axis is determined by the data values in the archive file. By default, the Y-axis scale
is set to show all data values, from lowest to highest value in the record. If the archive file contains irregular data that
results in an abnormal range scale, adjust the Y axis scale using the following steps:

1. Right-click on the tick marks to the right of the Y axis scale values. The Axis Settings dialog will appear (Figure
2.18).

2. Enter the desired maximum and minimum values in the fields provided.

If desired, change the major increments displayed along the Y axis. This value should be less than the difference
between the maximum and minimum values established in Step 2. Otherwise, the major increments and axis hash
marks will no longer be visible on the screen.

4. Click OK to apply the settings to the trend view.

To restore the scale to the actual maximum and minimum values in the archive file, click the Auto Calculate

checkbox(es) and click OK.
r Axis Settings
I

Auto Caloulate Max Value

Set Max., Value: 130.667
Auto Calculate Min Value
Set Min. Value: (11.879)

V| Auto Calculate Major Increments

St Major Increments:

OK Cancel

Figure 2.18—Accessing the Axis Settings dialog
Enabling/Disabling Parameter Trend Lines

By default, all archive parameters are displayed in the parameter table and in the trend log. Values are displayed only
for the parameter selected at any given time. To change the parameters displayed in the trend log, select a different pa-
rameter trend line or enables/disables parameter trend lines following the instructions below:

Click the parameter to be viewed in the graph (Figure 2.19, page 25). The parameter is highlighted in blue, its corre-
sponding trend line is bolded within the graph and markers indicating record locations within the trend line appear. The
yellow light bulb icon indicates that the parameter trend line is enabled for display.
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- displayed
¢ play!

M Gas 1 Propane 0.005 v
W Gas 1 Water 0.000 %
[ Gas 1 Hydrogen Sulfide 0,000 7]
0 Gas 1 Hydrogen 0,000 Q

Figure 2.19—Parameter (by record) table

Note Turning off the light bulb of a parameter that is highlighted in the table will cause the trend line and the Y axis to

disappear, but the parameter name remains on screen in grayed text. Click the grayed out parameter to restore
the trend view and the Y axis.

To view individual data point values, click the bolded line and move the cursor over the data points. The selected
parameter name and configured unit are displayed at the top of the graph, and the graph scale adjusts to frame the
values of the selected parameter.

To disable all parameter trend lines except the one that is selected (highlighted), click the Disable All button.
To enable all parameter trend lines, click the Enable All button.

To hide a parameter trend line, click on the yellow light bulb icon next to the parameter to be hidden. The light bulb
icon will change from yellow to blue, and the trend line will disappear from the graph. The parameter name will
remain at the top of the graph until another parameter is selected for display.

To display a hidden parameter trend line, click on the blue (disabled) light bulb icon. The icon will change to yel-
low, and the trend line will appear in the graph.

Analyzing a Single Trend Line

A user can examine records along a single trend line by clicking on a parameter in the left table. The parameter selec-
tion will appear highlighted in the table, and the name of the parameter will appear in the corner of the graph (Figure
2.20, page 26).

L.

Click on the trend line in the 7rend window and observe the dotted white cursor on the trend line. Move the cursor
along the parameter trend line and observe the changing values in the box linked to the cursor. The cursor latches
onto each data point (record) it encounters, and the associated date and time stamp and recorded value are automat-
ically displayed. This feature assists the user in determining the values for a single trend within the range without
scrolling.

When viewing by record, use the scroll bar below the bottom graph to move the graph across the vertical Record
Index line. The values of each data point that intersects the Record Index line will appear in the table to the left of
the trend log.

Note When viewing trends by date/time, the timestamp and log record number do not appear in the parameters table

and the record values do not appear during scrolling. However, clicking on the trend line and moving the cursor
over the data points (records) will display the date, time and value of when the record was archived.
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Figure 2.20—Log Trends view, single parameter shown
Only the trend line for the parameter that is highlighted in the table can be examined in this way. The cursor will not

latch onto data points along any other trend line. To view the values associated with a different parameter, select the de-
sired parameter in the table or click on a different trend line.

Viewing a Snapshot Report

The Snapshot report (Figure 2.21, page 27), like the Configuration report, allows a user to view and search flow run
and turbine input data, configuration values, sensor input readings and system data for a specific point in time. The re-
port can be exported and e-mailed to a technician for diagnostic help or to another user for data validation.

Snapshot reports are automatically generated and included in downloads from the Scanner 3100 flow computer. Snap-
shot reports are optionally available for download in Scanner 2x00 models. If a snapshot report is not included in a
download, the Snapshot tab will not appear in the Scanner Data Manager interface.

To view a snapshot report, simply click on the Snapshot tab. Use the scrollbar along the right edge of the screen to nav-
igate up and down in the report.
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Figure 2.21—Snapshot report

Searching the Snapshot Report

To search within

1. Click in the search field (Figure 2.22, page 28) and enter the search word or phrase.

2. Click Find. The search will identify where the search word or phrase appears.

a Snapshot report,

3. Repeat Steps 1 and 2 to search for another word or phrase.

Note The search field will retain your searches until you close the Snapshot report. To repeat a search, click on the

down arrow at the far right of the search field and select the term from the dropdown list.
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Figure 2.22—Snapshot report after search

4. Click Clear to return to the full Snapshot report.

does not show record | 4 [ »

Note The Clear button displays the full Snapshot report without deleting search parameters from the dropdown field.

5. Exit the Snapshot report to clear the search parameters list.
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Section 3—Exporting and Emailing Archive Data

Scanner Data Manager users can export tabular (spreadsheet) data, a snapshot or configuration report, or trend (graph)
data in common text or image formats for sharing with others (see Exporting Tabular Data, page 29 or Exporting

Trend Data, page 38). Users who wish to email tabular data or snapshot exports can process the export and the email

in one step (see Emailing Tabular Data, page 33). All exported data appears exactly as it does onscreen. For example,

if the user changes the order in which columns appear onscreen, this change will also be applied to the exported archive
file(s).

The type of data stored in an export file is identifiable by the letters at the end of the filename (unless the user over-
writes the filename), as shown in .

Table 3.1—Log Type Indicators in Filenames

Log Type Log Type Indicator
Daily History** D
Hourly (Interval) History** _H
Calibration Report L
Configuration Report C
Flowrun Configuration*® _F
Slave Configuration (3100 only) _F
Event Logs _E
Alarm Logs _A
User Change Logs* _u
Triggered History** (2x00/3100 only) T
Data Logger History* T
Data Logger Configuration* G
ScanPLC Logs* _P
Exceptions Report* X
Snapshot Report _S

* Created only by Scanner 11xx flow computers.
** Trend view export filenames contain a two-character suffix consisting of T and
the log type indicator Example: _TH (hourly trend).

Exporting Tabular Data
Tabular data can be exported in three formats

¢ Single log type (Exporting Data for a Single Log Type, page 30)
e Multiple log type (Exporting Data for Multiple Log Types, page 31)
¢ File format conversion (all log types included) (Section 5—Converting Data, page 57)

The Export Data button and dropdown menu (Figure 3.1, page 30) act as the gateway for all exporting functions.
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Figure 3.1—Export Data button and dropdown menu

Exporting Data for a Single Log Type
To export data for a single log type or report type

1. Select the tab for the log type/report type to be exported.

2. If exporting daily or interval history, note the tab(s) at the bottom of the screen. Archive files created by a Scan-
ner 3100 may contain multiple flow run/slave device tabs, and archive files created by Scanner 1x00 devices may
contain multiple flow run tabs. Select the flow run for which you want to export data. Each export of measurement
data will contain only data for the flow run tab selected at the time of export.

3. Click on the Export Data button in the left column of the screen and choose Export Selected from the dropdown
menu (Figure 3.1).

4. Note the filepath (Figure 3.2, page 31) and change if necessary. By default, export files are saved to the “C:\Cam-
eron Data\SDM\Exports” directory on the user’s hard drive.

Note Saving files to a directory other than the default will make the new directory the default.

5. Rename the file, if desired. By default, the filename includes the flow computer model, the type of download, the
flow run number, and a log type indicator (for example, S3100 Local 1 H.xlIsx).
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Figure 3.2—Export [Log Type} Data screen
6. Click SAVE to export the data.

Exporting Data for Multiple Log Types

To export multiple log and report types simultaneously

1. Click on the Export Data button in the left column of the screen and select Export to... from the dropdown menu

(Figure 3.1, page 30).

2. Select the desired file format, log types and reports from the options (Figure 3.3, page 32).

Note The Export Files dialog contains selection boxes for only those log types and report types contained in the
archive file. For example, if no daily log data was downloaded to the archive file, “Daily History (_D)” will not ap-

pear.

3. Note the “File Save Directory” location and change if desired. By default, export files are saved to the “C:\Cameron

Data\SDM\Exports” directory on the user’s hard drive.
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i Export Files

Selection Options

Select File Format

@ Excel Spreadsheet (XLSX) ) Word Document (RTF)

() Comma Delimited File (CSV) () Internet Document (HTML)
() AcrobatReader (PDF)

Select the log types and reports to include

Daily History (_D) [V] Event Logs (_E)
Interval History (_H) Alarm Logs (_A)

Configuration Report (_C) (V] Calibration Report (_L)
[] slave Config (_F)
Snapshot Report (_S)

File Save Directory

C:\Cameron Data\SDM\EXPORTS\ o

File Save Prefix  [53100_Complete (20) |

Lo [ concd |

Figure 3.3—EXxport Files dialog

4. Note the entry in the “File Save Prefix” field and change if desired. The prefix will become the first part of the
export file name. By default, this prefix includes Scanner model and download type.

5. Click OK to export the data.

Each log type or report will be saved as a separate file. The export filename will include the File Save Prefix (if present),
the flow run number, and the log type indicator, which is based on the user’s selection(s) in the Export Files dialog. Ex-
ample: S3100 Local 1 H xIsx.

Exporting Data Converted to Flow-Cal or PGAS Formats
To export the contents of the archive file to a third-party Flow-Cal (.cfx) or PGAS (.ana/.evt/vol) format:

1. See Section 5S—Converting Data, page 57, for information on changing conversion settings. This may be espe-
cially useful if gaps in the data are expected.

2. Click on the Export Data button in the left column of the screen and click the desired Export All as... selection
from the dropdown menu (Figure 3.1, page 30).

3. Note the filepath (Figure 3.3) and change if necessary. By default, export files are saved to the “C:\Cameron Data\
SDM\Exports” directory on the user’s hard drive.

4. Rename the file, if desired. By default, the filename includes the flow computer model and the download type (for
example, S3100 Local.ana).
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Emailing Tabular Data

Scanner Data Manager makes sharing data easy by allowing users to export and email data in a single step. To email
tabular data:

5. Click on the Email Data button in the left column of the screen to view export format selections.

Trending

Rec Timestamp

View Trends ]

16 2015-10-21 09:00:00
15 2015-10-21 08:00:00
14 2015-10-21 07:00:00
13 2015-10-21 06:00:00
12 2015-10-21 05:00:00
Email Data - 11 2015-10-21 04:00:00
2015-10-21 03:00:00
2015-10-21 02:00:00
2015-10-21 01:00:00
Ernail Selected 2015-10-21 00:00:00
2015-10-20 23:00:00

Email &ll as Flow-Cal File
Email All as PGAS File(s)

Ermli s 2015-10-20 22:00:00
Email C5V file 2015-10-20 21:00:00
Ernail PDF File 2015-10-20 20:00:00
Ernail RTF File 2015-10-20 19:00:00
Email HTML File 2015-10-20 18:00:00

2015-10-20 17:10:27

Figure 3.4—Email Data button and dropdown menu
6. From the dropdown selections, you can email three different types of exported tabular data:

e Single log type (Emailing Tabular Data for a Single Log Type)
*  Multiple log type (Emailing Tabular Data for Multiple Log Types, page 34)
e File format conversion (all log types) (Section 5—Converting Data, page 57)

Emailing Tabular Data for a Single Log Type
To export and email tabular data for a single log type or report,

1. Select the tab (Figure 2.3, page 12) for the log type to be exported and emailed.

Note The tab(s) at the bottom of the screen are archive files created by a Scanner 3x00 or 11xx Series computer and
may contain multiple flow run tabs. Only Scanner 3x00 archive datafiles may contain data for up to 20 slave
devices. Select the flow run (or slave device) for which you want to export data. Each export of measurement
data will contain only data for the flow run (or slave device) tab selected at the time of export.

2. Click on the Email Data button in the left column of the screen (Figure 3.4) and click the desired Email [log type]
file selection from the dropdown list. The Export [Log Type] Data to... dialog (Figure 3.2, page 31) will appear.

3. Note the filepath and change if desired. By default, export files are saved to the “C:\Cameron Data\SDM\Exports”
directory on the user’s hard drive.

4. Note the filename and change if desired. By default, the filename includes the flow computer model, the type of
download, the flow run number, and a log type indicator (for example, S3100_Local 1 H.xlsx).

5. Click Save to export the data. Scanner Data Manager will automatically open an email window on your computer,
attach the export file, and embed a brief description of the file in the body of the email (Figure 3.5, page 34).
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review this file: 53100_Complete_| i Elﬁq
File Message Insert Options Format Text Review Developer Adobe PDF [~ e’

5 - A= B ﬂ @ Q J @ \{] ¥ Fallow Up ~

EFY ¥ High Importance
Paste B 7 U |®& A =3 Address Check | Attach Attach Signature Attach File via
- J s BEook Mames File Item~ = Adobe Send & Track | & Low Importance

Clipbo.., Basic Text MNames Include Adobe Send & Track Tags = | Zoom

BT

To... “

\
=1 e || ‘
Send
Subject: ‘ Please review this file: S3100_Complete_FR1_H.xlsx ‘

|

Attached: 53100 Complete FRI Halsx (43 KE

Device/Meter Name: 53100/FlowRunl [#1]
Company Name:

Site/Well Name:

Field/Lease Name:

Location Name: 10.0.21.4

Legal Description:

Downloaded on:  2015-10-2313:27:11

SDM: 2.0.0-Betal3
Device Type:  53100-G1
Firmware: 1.228

Board ID: 0
Device SN: 6291470

Data:
Interval History - $3100/FlowRunl [#1] (2015-10-03 04:00:00 to 2015-10-23 13:00:00)

Figure 3.5—Automated email for single log file

Emailing Tabular Data for Multiple Log Types
To export and email multiple log types and reports simultaneously

1. Select Email Selected from the Email Data dropdown menu and select the desired file format and all desired logs/
reports from the options provided (Figure 3.6, page 35).

Note The Email Files dialog contains selection boxes for only those log types and report types contained in the
archive file. For example, if no daily log data was downloaded to the archive file, “Daily History (_D) will not ap-
pear.

2. Note the “File Save Directory” location and change if desired. By default, files are saved to the “C:\Cameron Data\
SDM\Exports” directory on the user’s hard drive.

3. Note the File Save Prefix and change if desired. The prefix will become the first part of the file name. By default,
this prefix identifies the file by Scanner model and download type.

4.  Click OK to export.

Wait momentarily while Scanner Data Manager opens an email window on your computer, attaches the export
file(s), and embeds a brief description of the file(s) in the body of the email (Figure 3.7, page 35).

Note Check the size of the export file. It may be necessary to compress (.zip) large files before emailing them.
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& Email Files

Email Files

Selection Options

Select File Format
@ Excel Spreadsheet (XL5X) () Word Document (RTF)
(7) Comma Delimited File (CSV) () Internet Document (HTML)

() Acrobat Reader (PDF)

Select the log types and reports to include

Daily History (_D) Event Logs {_E)
Interval History {_H) Alarm Logs {_A)

Configuration Report {_C) Calibration Report (_L)
Slave Config (_F)
Snapshot Report {_5)

File Save Directory

|c:\Cameron Data'\SDM\EXPORTS

File Save Prefix |53100_Comp|ehe (20 |

Figure 3.6—Email Files dialog

Format Text Review Developer Adobe PDF

dscut O ClANEE-D @@J g = IZ Q\!;]

¥ Follow Up -

B3 Copy 1 High Importance
Paste B I U | ® A = Address Check  Attach Attach Signature  Attach File via Zoom
~ <f Format Painter = Book Names  File Item~- = Adebe Send & Track | § Low Importance
Clipboard & Basic Text Names ‘ Include | Adobe Send & Track Tags 5| Zoom |
e ] |
=L | ‘
send J
| Subject: |P\easerwi=wtheseﬂ\es \

= 3100 Complete FR1 H.PDF (11 MBJ; = 3100 Complete FR2 H.PDF (19 MBJ; = s100 Complete FR1 D.PDF (1 MBJ; = sz100 Complete FR2 D.PDF (1 MEB];

Attached: ™) 53100 Complete System C.PDF (4 MB); ™ 53100 Complete System 5.PDF (2 MB; "o 53100 Complete System A.PDF [1 MBJ;
" 53100 Complete System E.PDF (1 MB); ™~ 53100 Complete System LPDF {1 MBI

Device/Meter Name: 53100
Company Name:

Site/Well Name:
Field/Lease Name:
Location Name: 10.0.21.4
Legal Description:

Downloaded on:  2015-10-2313:27:11

SDM: 2.0.0-Beta13
Device Type:  53100-G1
Firmware: 1.228
Board ID: 0

Device SN: 6231470

Data:
Interval History (1 2)
Daily History (1 2)
Configuration (System)
Snapshot (1)
Alarms (Summary)
Events (Summary)
Calibrations

¥ &

~

Figure 3.7—Automated email for multiple files
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Emailing Data Converted to Flow-Cal or PGAS Formats

To email the contents of the archive file in a third-party Flow-Cal (.cfx) or PGAS (.ana/.evt/vol) format

1. See Section 5—Converting Data, page 57, for information on changing conversion settings. This may be espe-
cially useful if gaps in the data are expected.

2. Click on the Email Data button in the left column of the screen and click the appropriate Email All as... selection
from the dropdown menu (Figure 3.3, page 32).

3. Note the “File Save Directory” location and change if desired. By default, files are saved to the “C:\Cameron Data\
SDM\Exports” directory on the user’s hard drive.

4. Note the File Save Prefix and change if desired. The prefix will become the first part of the file name. By default,
this prefix identifies the file by Scanner model and download type.

5. Click Save to export.

6. Wait momentarily while Scanner Data Manager opens an email window on your computer, attaches the conversion
file(s), and embeds a brief description of the file(s) in the body of the email (Figure 3.8).

EXIN™| = Please review these FlowCal files - Message (Plain Text) =B =

File Message Insert Options Format Text Review Adobe PDF & e
Bt = B jeor | i=misie o SSH @'} @ § ?’ ¥ Fallow Up ~

¥ High Importance

53 Cop
Paste B N B 7 U | % \ = = = | iZ = Address Check | Aftach Attach Signature
- # Format Painte = H Book Mames | File Item~ = 4 LowImportance

Clipboard ] Basic Text Names Include Tags »| Zoom

To..
i3
= e
Send L
Subject: Please review these FlowCal files

Attached: |_|53100 Complete F1.cfx (@ KB); | |53100 Complete F2.cfx (3 KB]; || 53100 Complete 51.cfx (4 KB

(L5

Device/Meter Name: 53100
Company Name:

Site/well Name:
Field/Lease Name:
Location Name:

Legal Description:

Downloaded on:  2015-02-20 14:36:48

SDM: 1.0.0

Device Type:  S3100-G1
Firmware: 1.050
Board ID: 0

Device 5Nz 6291499

Data:

Daily Logs

Interval Logs

Triggered Logs

Alarm Logs

Event Logs -

Figure 3.8—Automated email generated for converted files

Emailing an Archive (.sdf or .scm) File

To email an archive file (.sdf/.scm) to a technician or another Scanner Data Manager user, click the Email Archive File
button on the left side of the main screen (Figure 3.9, page 37).

Scanner Data Manager will automatically open an email window on the user’s computer, attach the archive file, and
embed a brief description of the file in the body of the email (Figure 3.10, page 37).

Note The .sdf/.scm file formats are proprietary and can be viewed only with Cameron software products designed for
this purpose. To share the contents of the archive file in a common format that can be opened outside of Scan-
ner Data Manager, see Exporting Tabular Data, page 29, Emailing Tabular Data, page 33, and Exporting
Trend Data, page 38.
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&% 53100_Complete sdf X |

Device Meter

!

Export Data -

Interval History [ Daily History "Conﬁgurat'n

Reports

Print Interval History -

Custom Reports

Trending

View Trends

() By Records
@ By Date/Time =

Email Archive Filz

Email Data v

I
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Date/Time takes
longer to load and
does not show record
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Figure 3.9—Location of Email Archive File button
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Note

Check the size of the export file. It may be necessary to compress (.zip) large files before emailing them.
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“ 1 oaciEE s B @ ) [ :
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Clipboard £l Basic Text Names Include Tags u| Zoom
Tor ] | |
—T
=1 ol ‘
Send
Subject: |Please review this file: 53100_Complete sdf ‘
HHEEE | ¥ $3100 Complete.sdf 30 ME) ‘
lin}

Version: SDF 2.3
Creator: 53100-G1
Firmware: 1.050
Created On:
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- Data-
Daily Logs
Interval Logs
Triggered Logs
Alarm Logs
Event Logs
Configuration (Full}
Archive Configuration
Snapshot

Figure 3.10—Automated email generated for archive file
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Exporting Trend Data

Trend data may be viewed by record or by date/time, and exported to .pdf, .rtf, .bmp, .jpg, and .gif image formats. See
Customizing the Trend Graph View, page 17 and Viewing Trends by Date/Time, page 21 for details about viewing
options.

To export trend data, follow the procedure below:

1. Click the tab for the log type desired and apply any filters or sort order selections desired.

2. Select the desired viewing option (by record or by date/time), and click the View Trends button on the left side of
the main screen.

3. Configure the trend view that you want to export using the zoom and parameter display tools on the View Log
Trends screen.

4.  When the trend image is exactly as you want the export file to appear, click on the Export button at the top left of
the View Log Trends dialog (Figure 3.11).

5. Select the export file type from the dropdown list.

Note Exported files will appear exactly as they do on screen with the following exceptions. Trend View .pdf files will
have a white background when viewed electronically or printed. All exported trend files will contain a header,
footer, and a legend detailing the trend lines.

6. Change the filepath if desired. By default, export files are saved in the “C:\Cameron Data\SDM\Exports” directory
on the user’s hard drive.

ﬁ View Trends

Print Trend Export -

Log Trends Export to PDF File
Export to RTF File

Export to BMP File
Export to JPG File

— Export to GIF File Right click scale to
Enable All Disawe s L T B ] | Set Time Axis Range | | Zoom Out Time Axis ‘ | Zoom In Time Axis | ‘ Reset Time Axis lly adjust values

|pa'ir‘:e:;wp ‘\;:‘::4271491%@ [ ]a Flow Run 1 Energy Total (MMBTII)
Log Record No. 2553 140 ]
B Flow Run 1 Vohme 52.327 MCF 7 :
M Flow Run 1 Mass Total 2452,115 LEM 7 :
B Flow Run 1 Energy Total 58,187 MMBETU 7 :
B Differential Pressure 30,850 In H2C: Gl :
I Static Pressure (G) 1075739 PSIG 7 :
B Process Temperaturs 52,115 Deg F 7 :
B Flow Ren 1 Flow Time 3500,000 sec 7 :
M Test Oil Grand Totsl 10405.388 BEL @ :
B Test Gil Vohime 0,000 BEL W i
M Test Gil Flow Time 0.000 sac @ ':'l"'
B Test H2O Grand Total 3120.943 BBL 7 :
W Test H2O Volume 0.000 BEL 7 v :
Visible Axis :
Inner Right Axis :
Note: Unused - :
Left Axis follows Middle Right Axis : _

parameter sefection .
Unused Record Index

Quter Right Axis

Unused

4 r

Figure 3.11—Log Trend view showing Export button and dropdown menu
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7.

10.

Change the filename if desired. By default, the filename includes the flow computer model, the type of download,
the flow run number, and a log type indicator (for example, S3100 Local 1 TH.xIsx).

Click Save to export the trend image.
Repeat Steps 3 through 8, as desired, to capture more sections of the trend log.

Click the Done button in the upper right corner of the View Log Trends dialog to exit the trend view.
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Section 4—Generating Reports

Flow data, device configuration and calibration data, events, and alarms can be captured in a report that can be printed
as a hard copy or exported to .pdf format for distributing electronically. Scanner Data Manager supports two types of
reports:

e A standard report with a pre-defined layout that matches the main screen layout (see Standard Reports, page 42
and Figure 4.1)

* A custom report that allows the user to specify content and personalize the presentation with a company name,
logo, and contact information (see Custom Reports, page 47 and Figure 4.1).
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Figure 4.1—Comparison of standard report vs. custom report
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Standard Reports

A standard Scanner Data Manager report can be generated for any data type. Data types vary depending on the Scanner
device used to generate the data. Table 4.1 provides a brief overview of typical report types and their contents.

Table 4.1—Standard Reports

Report Description

Interval/Hourly History Displays data generated for pre-defined intervals and parameters, including Flow Run Volume,
Flow Run Mass, Flow Run Energy, Differential Pressure, etc. Each record includes the Record
Number and Timestamp.

Daily History Displays data generated for a 24-hour period, including Flow Run Volume, Flow Run Mass,
Flow Run Energy, Differential Pressure, etc. Each record includes the Record Number and
Timestamp.

Configuration (System and Flow Displays the system and flow run configuration settings in one or two tabs, depending on the

Run) Scanner device in use. Scanner 3100 slave data are stored in separate tabs.

Snapshot Displays live and calculated parameters for a user-specified point in time.

Alarms Displays alarm activity for the Scanner. An alarm log is generated each time a selected

parameter deviates from its user-selected set point(s). Alarms are logged by date and time.
Each record includes the Modbus register name, status or type of alarm activated, and the
associated value and unit, where applicable.

Events Displays user changes, such as K-Factor, orifice meter factor, cone meter factor, plate and
cone size, gas composition, input settings and resets. Events are logged by date and time.
Each record includes the Modbus register name, as well as the old and new values of the
parameter.

Calibrations* Displays the instrument’s input calibration settings for quick reference.

*Calibrations and user-initiated changes for Scanner 11xx devices are stored under a User Changes tab. To generate a Scanner
11xx Calibrations report, the user must connect to the Scanner 11xx device through ScanWin, the proprietary software interface for
Scanner 11xx devices.

For some log types and reports, archive data is divided into multiple tabs at the bottom of the screen (Figure 4.2, page
43). For example, interval and daily history data are divided by flow runs. Similar divisions exist for alarms, events,
and slave device configuration data.

Where a log type or report includes multiple tabs, the user has the option of creating a report for a single “current” tab
or for “all” tabs. Log types and report types containing these options are identified by the dropdown arrow on the Print
[Data Type] button at the left of the screen (Figure 4.2, page 43).

Creating a Standard Report for “Current” Tab

To create a standard report for the “current” selected tab (for example, Flow Run 1 of a multi-flow run log)

1. On the main screen, click on the data type (tab) for which you want to create a report (Interval History, Daily
History, Configuration, etc.). Note that the Print button under the “Reports” section on the left side of the screen
changes to reflect the data type (tab) selected.

2. If the archive file contains multiple flow runs or otherwise divides log data between multiple tabs, click the desired
tab at the bottom of the screen.

Note For information on creating a standard report for data collected from multiple flow runs, see Creating a Stan-
dard Report for “All” Tabs, page 45.

3. Click the Print [Data Type] button and select “Current [Data Type]” from the dropdown menu (Figure 4.2, page
43). A preview of the report will appear (see Figure 4.3, page 43).

4. Check the formatting of the preview. If desired, change the page format settings using the Page Setup dialog (Fig-
ure 4.4, page 44) on the Preview screen. From this dialog, changes can be made to page orientation, margin size,
header and footer size and content, and scaling of the data grid.
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Note
when closing Scanner Data Manager.

Changes made to the Page Setup dialog apply only to the current report(s) being created and are not saved
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Figure 4.2—Daily History and Alarm tabs showing data divided into multiple tabs
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Figure 4.3—Print preview screen in landscape orientation (default)
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Figure 4.4—Page Setup window, orientation setting
Printing a Standard Report

To print a standard report

1. Click the Print Dialog button in the top left corner of the Print Preview screen (Figure 4.5).

2. Verify that the printer selected is appropriate for your computer. Change the printer selection if desired.

3. Note the page range listed in the lower left corner of the Print dialog. Change the range if desired.

4. Click Print.

CAUTION Large files can result in reports that are several hundred pages in length. Note the page count in

the footer of the Print Preview screen before printing and adjust the page range if desired.

CesB - pums ) ﬂ
Lo Preview Frinter
o - ame: 2 \\Dcrps01\DCNRXS4 - TOSHIBA e-Studio 5500¢ - Fr ~ ~ Properties...
 C |9
lb:} : Status:  Ready Network...
Design... Rebuild Print Type: TOSHIBA e-5TUDIOS5500c PS
\ - = ‘Where: 1P_10.0.21.204
Repeort |5 Format Comment:  Toshiba eStudio 5500¢ - DCN - Front Office / RXS4
Marging Left: 0.5in  Top: 1.46in  Right: 0.5in  Bottom: ["IPrint to Fle - Browse...
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], o e o . . . S Al Number of Pages: Al =
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Eblvi:l;‘lhtcz Hame: 53100 Pages: 1-236 | Collate Coples
iCompany Name: Company .
iSite/Well Name: Site Enter page number and/or page ranges 51 r5d ras
‘Field/Lease Name: Field separated by commas. For exampie: 1,3,5-12. 1 3 4
iLocation Hame: Locaticn
........ R [ Pogesctip.. | [Pt [ conca
i Rec Timestamp Status Flags
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2 2014-11-03 14:00:00 EFI HC

Figure 4.5—Print Dialog window

If multiple reports are to be printed and the same settings will be used for all, you can bypass Step 1 above after
you verify the settings for the first printing, and click the Print icon at the top of the Print Preview screen to print
subsequent reports without a preview.

Note
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Exporting a Standard Report to PDF

The following procedure is recommended for generating a .pdf when changes to the presentation (such as page size,
margins, orientation, etc.) are desired. If no formatting changes are desired, the export features described in Exporting
Tabular Data, page 29 and Exporting Trend Data, page 38 can be used to generate a .pdf report.

L.

Click the Export to PDF button in the top left corner of the Print Preview screen. A PDF Export Options dialog
will appear, as shown in Figure 4.6.

Adjust the pages to be exported if desired on the Pages tab.
Click OK to exit the PDF Export Options dialog. A Save As dialog will open.

In the Save As dialog, verify or change the filepath and enter a unique filename for the .pdf. The default filepath is
“C:\Cameron Data\SDM\Exports”.

Click Save to create the .pdf.

ﬁ & JEE] 5 (PL‘.}— Export uFtIC-'T'E)
Je Preview [ . .
| Export | Pages | pocument Information | security |

ok e j 5 ‘_@ [ 4 Format ~
B . ~'-m Backgroun o al
Design... Rebuild Print l;railr;tg SZ;_?;“ 53 Fitto Page e
Report Output ‘ - Format Pages:
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.................................................................
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Figure 4.6—Export to PDF menu

Creating a Standard Report for “All” Tabs

If a download file includes more than one flow run and all flow run data for a selected log type or report are to be in-
cluded in a report, use the following procedure to create the report.

To create a standard report for all tabs (for example, Flow Runs 1 and 2 of a two-flow run log)

1.

On the main screen, click on the data type (tab) for which you want to print a report (Interval History or Daily His-
tory). Note that the Print button under the “Reports” section on the left side of the screen changes to reflect the data
type (tab) selected.

Click the Print [Data Type] button and select “All [Data Type]” from the dropdown menu (Figure 4.7, page 46).
The Print dialog will appear (Figure 4.8, page 46).
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@ S3100LK_Complete 110614.zdf - Scanner Data Manager

Eile Options Help
= W

Reports Sort Order

J @5 53100LK_Complete_110614.sdf X

Poll Date: 2014-11-06 10:56:44

| ExportData  ~| Interval History | Daily History |

M

[ printDaiy Hstory ~|| [Defeut (As downloaded)

Current Flow Run
All Daily History

Figure 4.7—Reports>Print dropdown menu with “All [Data Type] History” selected

3. Select Preview in the bottom left corner of the Print dialog.

Note If multiple flow runs are included in the report, preview screens will display flow runs one at a time. For example,
if a report contains Flow Run 1 and Flow Run 2, Flow Run 1 will be displayed in the first preview dialog. The
user must close the preview screen for Flow Run 1 before the preview for Flow Run 2 will appear.

Print

Printer
Name: @ \\Denps01\DCNRX54 - TOSHIBA e-Studio 5500¢ -Fr ~ | | Properties... |
Status: Ready | Network.. |
Type: TOSHIBA e-STUDIOS500c PS
Where: 1P_10.0.21.204
Comment: Toshiba eStudio 5500c - DCN - Front Office / RX54
.| Print to Eile - Browse...
Page range Copies
o al Mumber of Pages: Al

Number of Copies: ‘

| Collate Copies

1| 1 2| 2 3| 3
Preview... | pint || cencel |

Figure 4.8—Print dialog showing Preview button

4. Follow the instructions for Printing a Standard Report, page 44 and Exporting a Standard Report to PDF, page

45.

5. Ifareport for another data type is desired, click the tab for that data type and repeat the steps above.

CAUTION

Large files can result in reports that are several hundred pages in length. Note the page count in
the footer of the Print Preview screen before printing and adjust if required.
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Custom Reports

Scanner Data Manager provides some simple tools for creating custom, personalized reports on demand, complete with
a company name, logo, and contact information. See Figure 4.9 for a sample custom report.

Two template types are included in the program:

e Generic Template—includes parameters that are common to all Scanner devices (recommended for users who want
to create a series of reports that contain the same information in the same order)

e Production Report Template (Scanner-specific)—reflects the available inputs and outputs of the device in addition
to the basic parameters in the generic template

The template files are easily modified to meet a user’s needs. A user can add or delete parameters (columns), rename pa-
rameters, change the order in which parameters appear, and save changes as a new template for future use. It is recom-
mended that users follow three simple steps to create a custom report:

1. Define common default settings, which will be available for use in all report templates. See Setting Common De-
faults, page 48 for more details.

2.  Modify a model-specific Production Report template and save as a new template. See Configuring Columns, page
50 and Changing Extra Headers and Summary Items, page 52 for more details.

CAUTION Modifying a Scanner-specific Production Report will overwrite the existing template. See Adding
and Deleting Templates, page 50 to learn how to create a new template without overwriting the
existing template.

3. Generate a custom report using the Custom Report Options dropdown menu accessed from the main screen. See
Figure 4.10, page 48 and Viewing and Printing a Custom Report, page 54.

Company Name
StreetAddress —a— Text Block Logo —p |
City, State Zip Production Report
Device/Meter Name:  S3100/FlowRun1 (#1) Downloaded on: 2015-10-29 09:36:09
CompanyMame Company SOM: 2.0.0 -Beta 13
SiteWell Name: Site Device Type $3100-G1
FieldLease Name Field Firmware 1.230
Location Name Location Board ID: 0
Legal Desdription Legal October 20, 2015 Device SN: 1234567890
Contract Hour 8:00 AM Pipe Size 127.000 mm
(DF’ Range -200.00 - 200.00 "H20@68F SP Range 0.0 -1500.0 ps\g)
Date Time Diff. PLePsé Sta‘i:::gsi Temn%
2015-10-2017:11:35 0.000 0.000 15556 Extra
2015-10-20 18:00:00 0.000 0.000 15556 Header
2015-10-20 19:00:00 0.000 0.000 15556 Items
2015-10-20 20:00:00 0.000 0.000 15556
2015-10-20 21:00:00 0000 0.000 16556
2015-10-20 22:00:00 0.000 0.000 15556
2015-10-20 23:00:00 0.000 0.000 15556
2015-10-2100:00:00 0000 0.000 16556
2015-10-2101:00:00 0.000 0.000 15556
2015-10-2102:00:00 0.000 0.000 15556
2015-10-2103:00:00 0000 0.000 16556
2015-10-2104:00:00 0000 0.000 16556
2015-10-2105:00:00 0.000 0.000 15556
2015-10-2106:00:00 0000 0.000 16556
2015-10-2107:00:00 0.000 0.000 15556
2015-10-2108:00:00 0.000 0.000 15556
Weighted Avg. 0.000 0.000 15556
Average
Minimum —-g— Summary
Maximum ltems
Total
Scanner Data Manager - Daily Report 10f26 Created On: 2015-10-29 17.40

Figure 4.9—Sample custom report showing customizable elements
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Setting Common Defaults

Common defaults are options that apply to every report template regardless of the data source or Scanner device.

To establish these defaults, choose Options>Custom Report Options (Figure 4.10). The dialog will automatically open
to the Common Defaults screen (Figure 4.11).

Sptons]

Viewing Options
Trending Options

Conversion Options

Custom Report Opticns

Logging Level

. [7] Indude Logo?  Position always top right (if shown)

[] Indude Extra Header Items?

Page Size |Letter (8 %" x 119 ~

. [¥] Indude Address? Position always top left (if shown)

Company Name
Street Address

City, State Zip

Items will appear in the position shown

oreoten

User Text

Type User Text Type User Text Type

|Unused > Unused Unused v
|Unused - Unused Unused -

| Unused % Unused Unused v

| Unused X Unused Unused v

| Unused v Unused Unused M

Summary Rows
Type (Weighted Avg. ~ | [Average  ~] [Minimum v| [Maxmum  ~] [Total -
Delete User Text Weighted Avg. Average Minimum Maximum Total

Figure 4.11—Custom Report Options screen showing Common Defaults dialog

From this dialog, the user can change the following settings to meet specific needs:

Note Changes made to the Common Defaults report will apply to all templates unless changed.

Page Size

By default, reports are configured to be letter size. Use this option to change the page size.

Orientation

Users can print or export reports in Landscape (wide) or Portrait (long) orientation. Landscape orientation is recom-
mended for reports containing a large number of columns or extra headers because it allows more columns to appear on

a single page.
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Logo

This option allows the user to include a company logo within the header. The logo will appear in the upper right corner
of the report. File formats .bmp, .jpg, .jpeg, .png, .efm, and .wmf are supported.

Address/User-Specified Text

Three lines of user-specified text can be used for a company/customer address or other text the user may wish to add to
the report header. Text will appear in the order it is entered by the user and will be displayed in the upper left corner of
the page.

Extra Header Items

A basic set of parameters, such as device/meter name, company name, site/well name, firmware version, and device se-
rial number, is included in the standard header of all reports. However, custom reports allow the user to include other
configuration items in a second header (Figure 4.11, page 48). The user can select which parameters to include and
change the text description used to identify a parameter by entering text in the “User Text” field. Extra header selections
available will vary, depending on the device used to generate the archive file.

Note The “User Text” field will accept up to 15 characters.

Summary Rows

Summary rows enable the user to include in the report a value such as a total or average that is calculated over a logging
period. The logging period could be a month for daily logs or a day for interval logs. These rows are presented in the or-
der shown on the screen. Up to five summary rows are supported: Average, Flow Time Weighted Average (the average
of values accumulated when measurable flow exists), Minimum Value, Maximum Value, and Total. As a default, the se-
lected Type name will be used to define summary items in the report, but the user can override this text by editing the
text in the “User Text” field. Each type can be used; however, types cannot be repeated within a report.

Production Report Templates

Report templates are individual templates from which a user can create custom report templates. By default, there are
standard production report templates for each Scanner device, as well as a Generic template that contains parameters

common to all Scanner devices (Figure 4.12).

w Customn Report Options
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: \ Report Mame |Produchor1 Report ‘ Device Type |Scanner 3x00
Report Templates
i Production Report | Data | Inchude In 1 | corI;ngin e El
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Scanner 3x00 Column Type User Text Decimals | Width |Awg. |Total| N/A | NJA | NfA et s el et
i [Production Report| Date/Time Date/Time 120 @ ] ] = ] column widdh)
Sample Report Temd Flow Run Volume Volume 0.000 85 [ N s Add Cal
Secanner 2x00 Flow Run Mass Mass 0.000 as [ o O =] oumn
-Production Repart Flow Run Energy Energy 0.000 as [ | ] =]
Seanner 11 Flow Run Diff. Pres.  Diff. Pres, 0.000 i O 8 5 B
_--Froduction Repar Flow Run Stat. Pres.  Stat. Pres. 0.000 70 0O B 0 O
Flow Run Temperature Temp. 0.000 70 [} [} ] ]
Common Defaults Flow RunFlow Extn  Flow Exin 0.000 n 0 B O O O
Generic Pro ductior‘1 Flow Run Density Density 0.000 70 B B B B B
Report and Flow Run Vol. Heat Valu Vol. Heat Value 0.000 70 0 B8 B =
Scanner-specific Flow Run Flow Time Flow Time 0 s0 [ 1 s
Production Report
templates Column Preview
Date[Time Volume Mass Energy Diff. Pres. | Stat. Pres. Temp. Flow Extn De
4] [ |
O I | » olumns [ Common Overrides _{ Page Overridesy
- If first wo eolumns are Dare/Time then From®and To™ are shown, otherwise Dara/Time uses History Timaszamp semings
Add Delete - I column does not exist in the dai then the next column will be shown.
- Summary fialds are definad within the Common Overrides tab.

Figure 4.12—Production Report template customization options
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Adding and Deleting Templates

To add a template, select the device category (Generic, Scanner 11xx Series, Scanner 2x00 Series, or Scanner 3x00) and
click the Add button on the bottom left of the Custom Report Options dialog (Figure 4.12, page 49). A blank template
based on the device category selected will appear. The user can customize the template, rename it, and save it as a new
template by clicking the Save Template button on the bottom right of the screen.

To delete a user-created template, select the template and click the Delete button on the bottom left of the screen (Figure
4.12, page 49). Default templates for each device type can be modified. However, users should proceed with caution.
Changes to default templates are permanent and the original templates can only be restored by reinstalling the Scanner
Data Manager software.

Note Modifying a model-specific Production Report template without adding a new template will overwrite the default
Production Report template.

Creating a New Report Template

Each Production Report template contains three views (Columns, Common Overrides, and Page Overrides) accessed by
three tabs at the bottom of the screen (Figure 4.12, page 49).

e The Columns tab allows the user to select the parameters (columns) to include in the report and to change the order
in which the data appears.

e The Common Overrides tab allows the user to add extra header and/or summary items.

e The Page Overrides tab allows the user to change the page layout, logo, and address. From the Columns tab, the
user can name a report template, select the parameters (columns) that will appear within the report, and change the
order in which they appear.

CAUTION If you do not save the template before exiting or before switching to another template, all
changes will be lost. It is recommended that the customized template be given a unique name,
rather than overwriting the standard template. If the default Production Report template is
overwritten, the user must unzip the backup files to restore the templates.

Configuring Columns

To establish the Columns tab settings for a new template

1. Click on the device type for which you want to create a new template, then click the Add button that appears on
the bottom left of the Custom Report Options dialog to create a blank template. By default, it will appear on the
Custom Report Options dialog as “Report.”

2. Replace the text in the “Report Name” field at the top of the screen to assign a name that uniquely identifies it.

Note The “Device Type” field is read-only and is self-populated to reflect the template selected. This field is informa-
tional only.

3. Verify that the Columns tab at the bottom of the screen is selected.

By default, the first column is Date/Time (same as shown in the log grids), and represents the end of the interval/
day. If the History timestamp is changed to mark the beginning of the record, the Date/Time entries will represent
the beginning of the interval/day.

Note If a beginning date and time is desired as well as an end date and time, add a new column for Date/Time as
described below and move it to the Column 2 position in the grid. Column 1 will display the “from” date and
time, and Column 2 will display the “to” date and time for the range. To move a column to a new position, see
Changing Parameters (Columns), page 52.
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4. Add parameters to the data grid in the center of the screen as follows.

a.

Click the Add Column button at the right of the data grid. The Add Column dialog (Figure 4.13, page 51)
will appear.

Select the parameter desired.

If the parameter being added is associated with a flow run or gas stream, the Add Column dialog will include

a user entry field for “FR or GS Index.” In typical use cases, where archive 1 is configured with flow run 1
parameters and archive 2 is configured with flow run 2 parameters, use the default value of 0. In the event flow
run | and flow run 2 parameters are combined in a single archive, the index value allows the user to specify
which flow run value is to be included in the report. For example, to add a column for Flow Run 1 Volume,
select Flow Run Volume as the data type and enter an index value of 1.

In the case of gas streams, the user identifies the type of gas in the data type field, and enters an index value to
designate the flow stream desired. For example, to include data from Gas Stream 5, enter an index value of 5.

Note

The “FR or GS Index” field will only appear for Scanner 3x00 parameters that are related to a flow run or gas
stream.

Enter a new parameter text description in the “User Text” field if desired.
Change the decimal places, if applicable. Up to seven decimals can be configured.

Change the column width, if desired. If you select a width that is too small, the data in the column may overlap
the previous column. Column width may be selected in unitless increments of five. Typically, column width is
changed only after all parameters are entered and the user can determine if width adjustments are required to
present the data properly.

To add the parameter to the bottom of the report in a summary row, select the checkbox(es) under “Include in
Summaries” to indicate the type of summary calculation required (average, weighted average, minimum value,
maximum value, or total). The selections available depend on the data type and whether summary calculations
are supported by the Scanner device used to generate the data.

By default, the summary rows enabled as Common Defaults will automatically apply to all existing templates
unless they are overridden from the Common Overrides screen. See Summary Rows, page 49 and Changing
Extra Headers and Summary Items, page 52 for details.

e Edit Customn Repoerting Column ﬂ
A '-..

Select type to indude
B
FR or G5 Index 0 0="first found, otherwise indax specified
User Text Flow Run Uncor, Acoum.
Dedmal Places 0.0000
Column Width 1 75
Indude in Summaries

(7] Weighted Avg. [] Average [~] Minimum [~ Maximum [~ Total

(o ][ cona ]

Figure 4.13—Add Column dialog

h.

Click OK to save changes, close the Add Column dialog, and add the column to the report.

5. Click Save Template in the bottom right corner of the Custom Report Options dialog above “OK” and “Cancel” to
save your progress.

All new columns will be added to the bottom of the grid on the Custom Report Options dialog, and to the far right of
the Column Preview bar. To move a column to a new position, see Changing Parameters (Columns), page 52.
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The number of columns included in a generated report will vary depending upon page orientation and total column
width. The “Columns in Report” section of the Custom Report Options screen (Figure 4.12, page 49) indicates the
total estimated number of columns to be included. If additional parameters are required, simply create another custom-
ized report. If a parameter is not available within an archive file, it will be skipped and the next available parameter for
which data exists will be listed.

Changing Parameters (Columns)

Parameters (columns) can be added or deleted, and moved left or right on the report (up or down on the grid) using the
appropriate buttons.

Note To move a parameter (column) left or right, click a parameter to highlight it in the grid, and click the Move Left
or Move Right button. The selected data row will move up or down within the grid, but in effect, the column con-
taining the grid data is moving to the left or right, as shown in the “Column Preview” grid near the bottom of the
screen.

To make changes to an existing column (to include data type, data type description, decimal format, column width, or
summary item selections)

1. Click the Change Column button on the Custom Report Options screen.
2. Make desired changes on the Change Column dialog (Figure 4.14).

3. Click OK.
] @ Edit Custorn Reporting Celurnn A 1
Change Column, #

FR or G5 Index 0 @ = first found, otherwise index specified
User Text Temp.
Decimal Places .00

Column Width n“-

Include in Summaries

[ weighted Ava. Average Minimum (] Maximum [&] Total

o] [

Figure 4.14—Change Column dialog

Changing Extra Headers and Summary Items

From the Common Overrides tab (Figure 4.15, page 53), the user can override extra header items and/or summary
items. Overriding these settings may affect how the columns appear and which summary items appear on the generated
report.

To establish the Common Overrides tab settings for a new report

1. From the Custom Report Options dialog, select the template being created.

2. Click on the Common Overrides tab at the bottom left of the screen.

3. To change or add extra header items, click the Override Extra Header Items checkbox.
4

Select the data type from the dropdown menu to add it to the header. The data types in the dropdown menu vary
depending on the type of data obtained from the Scanner device. To change the display text, enter the desired name
for the type in the “User Text” field.
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Note By default, extra headers that are enabled as Common Defaults will automatically apply to all existing templates

unless they are overridden on the Common Overrides screen. To disable these items from a Scanner-specific
template, navigate to the Common Overrides tab and check the Override Extra Header Items checkbox, leav-
ing all the header items labeled “unused.”

To add or change the summary items for a selected data type, click the Override Summary Items checkbox.

Select the desired summary type from the dropdown menu. The summary types available will depend on the data
type selected. By default, the summary type description will be displayed in the report. To change the display text,
enter the desired name for the summary item in the “User Text” field.
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‘ Override Summary Items ’
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User Text Average
Weighted Avg.
Mirirum
Maximum
Total
< m v | | Columns ;{Common Overrides A/Page Overrides
- If first two columns are Dara/Time then From'and To' are shown, otherwise Dare/Time uses History Timestamp sermings. | Save Template |
Delete - If column does not exist in the date then the next column will be shown. -

- Summary fields are defined within the Common Overrides w@b.

Coc ] Lo

Figure 4.15—Common Overrides tab

7.

Click Save Template to save your changes.

Customizing the Page Layout

From the Page Overrides tab (Figure 4.16, page 54), the user can change the pages size and/or orientation, add or
change a logo, and add or change an address or text block to the report template.

This feature is especially helpful for users who want to generate a custom report with customer-specific information
and graphics for each of their customers.

To establish the Page Overrides settings for a new report

1.

From the Custom Report Options dialog, click on the Page Overrides tab.
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& Custom Report Options

Custom Report Options

Report Name Pmdmmﬂ.epoct Device Type  |Scanner 2300

Generic ( [[] override Page Layout )
-Production Report PageSize |Letter (81" x 117 v | Orientation [Landscape ~
Scanner 3x00
‘- Production Report
Scanner %00 [] Override Lago?) Position always top right (if shown) ["] Override Address? )Position always top left (if shown)
- Production Report Text
-Seanner 11xx Load Image
'~ Production Report

coluns. :.u-:omrm Overrides. :lPaqe Ove-rides.

- If first two columns are Date'Time then From"and To" are shown, otherwise Dace/Time uses Hiswry Timesmmp senings.
- If eolumn does not exist in the dat then the next column will be shown.
- Summary fields are defined within the Common Overrides tab.

Save Template

G (o

[ o ][ come |

Figure 4.16—Page Overrides tab
2. To change the page size and orientation, check the Override Page Layout box.

3. To add or change a logo, click the Override Logo box, then click Load Image, browse to the logo’s location, and
click on the file.

4. To add or change an address, click the Override Address box and enter text in the three fields below. The informa-
tion will appear on the report in the order in which it is entered.

Note It is not necessary to enter information in every field; however, if more than one field is used, enter the informa-
tion from the top down and do not leave the first row blank.

5. Click OK to save changes and return to the Tabular View dialog.

6. Click Save Template to save the new template.

Viewing and Printing a Custom Report

To view and print a customized report,

1. Click on the Custom Reports button on the left side of the main screen (Figure 4.17, page 55). The Custom
Reports dialog (Figure 4.18, page 55) will appear, from which the final look of the report can be defined.

Note The Custom Reports button is only enabled for the Interval and Daily Log tabs. Other tabs do not support this
feature.
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‘ @ 53100_Complete.sof X |

Export Data 'l

Reports

Print Interval History ']
Custom Reports

L S T

Interval History rDaﬂylil'jl:t:b ry

Sort Order |Date/Time - Latest Fi

of Visible Records: 236

Figure 4.177—Custom Reports button on main screen

-
ﬁ Customn Reports

Custom Reports
Select Template Select Date Range

Scarner 300 - Sample Report Template - @ Al Dates/Times
() Selected Dates/Times

Select Type of Report (@ Range by Month/Day |None selected -

_ r Custom Range
@ Daily Logs Monthly Report .

Start Date |11/2/2015 8:52:31 AM -
() Interval Logs  Daily Report
End Date [11/4/2015 8:11:28 AM -

(Selec:t Flow Archives/Slave Devices)

@ A&l Flow Archives/Slave Devi
@ ow Archives/Slave Devices

(71 Selected Flow Archives/Slave Devices

Flaw Archives E::' Print F'rewev.\u
Flows Archive #1 Flow Archive #2 () Output ta Printer
@ Output to File

Slave Devi Acrobat Fieader [FDOF] =
RS (LSESS File Format  Acrobat Feader (PDF) =[] Email Filez]

Slave #1
- File Prefis [ Open After Export
Output Directory
|E:\Eamer0n D ata*SO4Reports =)

Output Files to Field Mame and Site Mame Subdirectories

Create ] ’ Close

Figure 4.18—Custom Reports dialog

2. From the Select Template dropdown menu, select the desired template for use in generating the report. At a mini-
mum, available templates will include a generic template and a Scanner-specific template. To add custom templates
to this list, see Creating a New Report Template, page 50.

3. Select from the available report types:

e Monthly Report containing data from Daily Logs
e Daily Report containing data from Interval Logs
If a log type (daily or interval) is not available in the archive file, the option for that report type will be unavailable
and the selection will default to the available option.

4. In the “Select Flow Runs” field, select the flow runs/archives for which reports are generated. Available selections
vary depending on the device type used to produce the archive file.

5. Specify the dates and times to be included in the report from the “Select Date Range” field:

e All Dates/Times containing all date and time ranges within the archive file
¢ Selected Dates/Times containing

— A range by month and day

— A user-defined range, including start date and end date

Note The ranges available are limited to the dates and times included in the available data.
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Note If the logs contain data of differing ranges, some reports may not include all the data or may fail to generate. For

example, if you choose to print all flow run/slave device reports for February and Slave Device 6 was not added
until March, there will be no data for Slave Device 6 and no report will be generated for that device.

6. From the “Select Output” field, choose one of the following output options:
* Print Preview—Displays a preview of each flow run report before printing
e Output to Printer—Sends the report file directly to the default printer
*  Output to File—Saves the report file in the user-specified format to the user-specified directory
When “Output to File” is selected, the user can define the output with several additional optional settings:
e Check Email File(s) if the output file to automatically attach the output file to an email window.
* Check Open After Export to automatically open the report on the computer screen.
e Click the File Format dropdown menu and select the file type. Options are .pdf, .rtf, .html, .xls, or .txt format.
e Enter a file prefix, if desired, for ease in categorizing reports for quick identification.
*  Modify the “Output Directory” filepath, if desired. The default directory is “C:\Cameron Data\SDM\Reports”.
* Check Output Files to Field Name and Site Name Subdirectories to create Field Name
and Site Name subfolders on your hard drive for storing the reports (“C:\Cameron Data\SDM\
Reports\<Field Name>\<Site Name>").
7. Click the Create button to generate a report template. The settings used to generate the report will be saved as a
starting point for creating additional reports.
8. Click the Close button to exit the Custom Reports dialog.
Important If you click the Close button and close the Custom Reports dialog without clicking the Create but-

ton and generating a report, the selected settings will not be saved for future use.
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Section 5—Converting Data

Scanner Data Manager offers both individual file conversion and batch conversion. Data can be converted and saved in
third-party Flow-Cal® and PGAS™ formats, as well as in formats that are specific to Scanner 11xx devices.

Batch Conversion

Batch Conversion allows the user to convert multiple files to a different file format at the same time. Archive data can
be batch converted to FlowCal, PGAS, BDMS Generic (11xx only), and GDS (11xx only) formats.

Note For a complete understanding of filepath locations, default settings, and file naming options, review the Conver-
sion Options dialog described below before attempting a batch conversion.

Conversion Options

Archive data (.sdf/.scm) files are automatically archived upon conversion, ensuring a complete measurement audit trail.

File Locations

Figure 5.1 shows the default filepaths provided for storing input data files and converted files. To assist with trouble-
shooting, input data files for successful conversions are stored separately from input data files for failed conversions.
Likewise, output files for successful conversions are stored separately from output files for failed conversions.

By default,
e Archive files that are successfully converted are stored in “C:\Cameron Data\SDM\Convert\Archived”.
e Archive files associated with failed conversions are stored in “C:\Cameron Data\SDM\Convert\Failed”.

¢ Output files that are successfully converted are stored in the user-defined directory that is entered on the Batch
Conversion screen (see Figure 5.8, page 61).

e Output files associated with failed conversions are stored in “C:\Cameron Data\SDM\Convert\Output”.

Users may edit these filepaths if desired.

@ Conversion Options
- -

Figure 5.1—Conversion Options dialog

Conversion Options
-~{File Locations|
FlowCal Defaults

File Naming

- Common Defaults
- Orifice Defaults

H - Pulse Defaults

- PGAS Defaults

File Locations
Batch File Locations
Input Archive File Handling
Select Failed Conversion Directory

I.C:\,Cameron Data\sDM\CONVERT\FAILED = |

Select Successful Conversion Directory

'C:\Cameron Data\SDM\COMNVERT'\ARCHIV (= |

General Logging Settings
[ Use Advanced Logging

Select Log Directory
EC: \Cameron 6ata'-Sbrv1'-LOGS &

Output Converted File Handling
Select Falled Output Directory
iC:\,Cameron Data\SDMYCONVERT\OUTPLS &= |

Note:
Successfully converted files are saved in
the directory defined when converting.
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Status Log

Following conversion, a status log providing conversion details is automatically displayed on screen and stored in the
log directory specified in the “General Logging Settings” section of the Conversion Options screen (Figure 5.1, page
57).

The level of detail is determined by the logging level selected from Options>Logging Level. If a detailed status log is
desired, check the Use Advanced Logging checkbox, and note the filepath for this log. If errors occur, the log can help
indicate the source of the problem.

If the user chooses a conversion type that is not supported by the archive file, the file will not be converted and it will be
moved to the “Failed” directory as defined on the Conversion Options>File Locations screen.

Flow-Cal Conversion Options

To access conversion options for Flow-Cal, select Options>Conversion Options from the main screen (Figure 5.1,
page 57).

When the Conversion Options dialog appears, choose FlowCal Defaults and specify the following options:

e File Naming (Figure 5.2)—Select Node Name + Flowrun Number or Flowrun Name in the “File Name” field and/
or the “Station Number” field

e Common Defaults (Figure 5.3, page 59)
e Orifice Defaults (Figure 5.4, page 59)
e Pulse Defaults (Figure 5.5, page 59)

Note Common defaults, orifice defaults and pulse defaults are defined by Flow-Cal®. Refer to the Flow-Cal docu-
mentation for information about what values should be entered.

To specify these options, click on the option to be changed and enter the parameter(s).

& ~ -

C_unversiun Options
- File Locations
+-FlowCal Defaults

FlowcCal - File Naming (Scanner 11xx Only)

| File: Naming File Name Station Number
Common Defaults _ _
i L-Orifice Defaults G Nede Mame + Flowrun Mumber 0- Mode Mame + Flowrun Number
i Pulse Defaults () Flowrun Name () Flowrun Name

i PGAS Defaults

oK -Canoe\

Figure 5.2—Flow-Cal File Naming dialog

58



Scanner Data Manager Appendix A

C°";Tzz;ii::"s FlowCal - Common Defaults
Name No.| Type g
Station_Number i 1 |A(16) Station Number (
i -Pulse Defaults Station_Name 2 |A{48) Station Name
- PGAS Defaults Meter_Serial_Number 3 |A(10)
Delivery_Date 4 |A(10)
Meter_Type 5 |a(1)
Hourly_Record_Span 6 |A(1)
Power_Source 7 |A(1)
Fitting_Type 8 |A(1)
Pressure_Base 9 |Real
|| Temperature_Base 10 | Real 5

Conversion Options

Camisreion Cptions FlowCal - Orifice Defaults

i~ File Locations
FlowCal Defaults

File Naming Name

Common Defaults =

Orfice Defauts | Flate_Material i
! Pulse Defaults Orfice_Plate_Size

- PGAS Defaults orfice_Reference_Temp

Type
A1)
Real

Ho.

15

28

29 | Real
DP_Calibration_Range-High 30 | Real
DP_Low_Flow_Cutoff 31 |Real
DP_Transducer_Range-High 32 |Real
DP_Low_Alarm 40 | Real
DP_backflow_Alarm 41 |Real
DP_High_Alarm 42 |Real

Figure 5.4—Flow-Cal Orifice Defaults dialog

onversion Dptions

Conversion Options

Conversion Options
File Locations
-~ FlowCal Defaults
- File Naming Name

FlowCal - Pulse Defaults

Type
Real

B|F

-~ Common Defaults
- Orifice Defalts k_factor
-[Pulse Defaults | Meter_factor 29 |Real
PGAS Defaults

Figure 5.5—Flow-Cal Pulse Defaults dialog
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PGAS Conversion Options

To access conversion options for PGAS, select Options>Conversion Options from the main screen.

When the Conversion Options dialog appears, choose PGAS Defaults. Conversion to PGAS format allows the user to
specify Meter ID Settings, Flow run Support, Missing First Record Data/Time Settings, and Default Logging Interval
by selecting the desired option(s) from the dialog (Figure 5.6).

e Conversion Options

=

Conversion Options
~-File Locations
- FlowCal Defaults
File Maming
Common Defaults
Orifice Defaults
Pulse Defaults
[PGAS Defaults |

PGAS Defaults (Scanner 11xx Only)

METER_ID Settings Flowrun Support
[ Monitor Runs Gas Runs

[7] Liquid Runs

@ Node name +Flowrun #
() Flowrun name

Missing First Record Date/Time Settings
PRODUCTION_DATE_START and FLOW_TIME_MINUTE handling
) Blank values

@ Use default logging intervals to compute

Default Logging Interval: | 60 :J Minutes

EE

Cancel

Figure 5.6—PGAS Defaults dialog

Cameron archives only provide an ending timestamp and PGAS requires a starting time for the first record and an end-
ing timestamp. To establish a starting time for the first record, select Blank Values, which leaves the timestamp blank,
or Use Default Logging Intervals to Compute, which calculates a starting timestamp based on the default logging

interval.

Performing a Batch Conversion

To perform a batch conversion of files to a third-party software format,

1. Place the files to be converted in a dedicated directory.

2. Choose File>Batch Conversion from the main screen (Figure 5.7). The Batch Conversion dialog will appear (Fig-

ure 5.8, page 61).

Eile

Options  Help

>

.

i

Open

Batch Conversion

Close

Close All Files

1 C:\Cameron Data\SDM\Slavedl_SA01_I_Full.sdf
2 C\Cameron Data\SDM\53100_Local.sdf

3 C\Cameron Data\SDM\53100_FAOL_I Full.sdf

4 Ch\Cameron Data\5DMA53100_Complete.sdf

Exit

Figure 5.7—File>Batch Conversion

3. From the Batch Conversion dialog

a. Select the “Input” directory (the dedicated directory established in Step 1)

b. Select the files to be converted (the default setting is “All Files”). If selecting individual files for conversion,
choose Selected Files, press and hold the <Ctrl> key and select each desired file from the list displayed.
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C.

d. Select the output directory where converted files will be stored.

@ Batch Conversion

Select Files to Corwert
Select Input Directary

| C5Cameron DatahSDM

@ AllFiles

(7)1 Selected Files

Mame =

<® DeviceMame_TR_Full sdf

¥ 53100_Complete. sdf

<% S3100_EA_Full sdf

<% S3100_FADT_D_Full sdf

< 53100_FADT_|_20151022 scf
< 53100_FADT_|_20151023 scf
<® 53100_FADT_| 20151024 sdf

T ]
1 1n ]

11.1is|
36—
219
Bae
e
12¢

il
r

Select Type of Conversion

Corversion Type

@ CFX [FlawCal)
) PGAS

(") BOMS Generic
) GDS

Select Output Directary

| CCameron Dat=hSDMAOONVERTAOUTPLITACFX

Begin Conversion

[11x= SCM Only)
[11:% SCM Only)

Alter Conversion

Figure 5.8—Batch Conversion dialog

4.
5.

6.

Click the Convert button to begin the conversion.

To exit the Batch Conversion mode, click Done.

Converting a Single File to Flow-Cal or PGAS Format

To export the contents of an archive file to Flow-Cal (.cfx) or PGAS (.ana/.evt/vol) format

1.

Click Save to export the data.

Emailing Converted Flow-Cal or PGAS Files

To convert and email the contents of an archive file in Flow-Cal (.cfx) or PGAS (.ana./.evt/vol) format

L.

Click Save to save the file.

Select the type of conversion desired. If the conversion format selected is not supported by the file data, the file
will not be converted and it will be moved into the “C:\Cameron Data\SDM\CONVERT\FAILED” directory.

When the conversion is complete, the View Logs screen will automatically open to provide status information. If
the Use Advanced Logging option on the Conversion Options dialog is enabled, advanced logs tab shows addi-
tional details about the conversion.

See Conversion Options, page 57 for information on changing conversion settings. This may be especially useful
if gaps in the data are expected.

Click on the Export Data button in the left column of the main screen and choose the desired Export All to...
selection from the dropdown menu (Figure 5.9, page 62).

See Conversion Options, page 57 for information on changing conversion settings. This may be especially useful
if gaps in the data are expected.

Click on the Email Data button in the left column of the screen and choose the appropriate “Email All as...” selec-
tion from the dropdown menu (Figure 5.10, page 62).

Wait momentarily while Scanner Data Manager opens an email window on your computer, attaches the conversion
file(s), and embeds a brief description of the file(s) in the body of the email (Figure 5.11, page 63).
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@ 5.L16977_Well#1_Gas_20110504_1632.5df - Scanner Data Manager
s

File Options Help

ell1_Gas 20110504 _1632.5df X | i 53100_Complete (20).5df 3¢ | i@ 53100_complete (1).seF |

” Device/Meter Name: S/L16977 Well#1 Gas Downloaded on: 2011-05-04 16:31:51 ”
Interval History | Daily History | Configuration | Alarms | Events | Calibrations | Log

Filter?
Export Allto Flow-Cal  fger [DatefTime - Latest First O Fiter
Export All to PGAS ) Filter by Month/Day  [None selected T] | StertDate [3/11/2010 10:00:00 M- |

Export Selected Filter by Date Range
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[ Export Data

Export to XLSX file

a

: Flow Run 1 Mass |Flow Run 1Energy |  Differential Flow Run 1 Flow
Export to CSV file Timestamp EiCRER IR Ao Total Total Pressure Time E |
Export to PDF File e il e

Export to RTF File 20110504 16 P e =l ] -
Export to HTML File 52.1941 26.5608 10019825 T7.4724 36000000

S —— 46.9898 2237.9526 52.2527 26.5171 1003.0107 75.6896 3500.0000
6245 002 46.8455 22310806 52.0923 26.2562 998.1213 74.2474 3600.0000
= 6244 2011-05-04 12:00:00 46.6923 223.7842 519219 26.1051 1002.2465 73.2984 3600.0000
6243 2011-05-04 11:00:00 46,9563 2236.3564 52.2154 26,1445 1003.3030 72.4243 3600.0000
6242 2011-05-04 10:00:00 46.6075 2219.7422 51.8275 25.6566 1003.3234 71.3988 3500.0000
*Viewing Trends by | 5241  2011-05-0409:00:00 46.5837 2218.6113 518011 25.6163 10017229 70.1751 3600.0000
Date/Time takes 6240 2011-05-0408:00:00 46,6507 2221.7988 51.8755 25.6263 995.9727 67.5180 3600.0000
‘r;’c:‘ia:\ltj?s‘e;iar:iurd 6239 2011-05-04 07:00:00 46.6747 2222.9434 518023 25.6972 993.0196 66.0992 3600.0000
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6234 2011-05-04 02:00:00 46.73649 2225.8838 51.9709 25.7873 991.7549 66.7077 3500.0000
6233 2011-05-0401:00:00 46.5395 2216.5039 517519 25.5972 593.0109 67.1638 3600.0000
6232 2011-05-0400:00:00 46.8530 2231.4338 52.1005 25.8968 993.2314 67.5193 3600.0000
6231 2011-05-03 23:00:00 46.6095 2219.8362 51.8297 25.7034 993.8235 68.2496 3600.0000
6230 2011-05-03 22:00:00 46.8863 2233.0210 52.1376 25.9914 996.1383 68.9203 3600.0000
6220 2011-05-03 21:00:00 46.8563 22315925 52.1042 25.9387 599.1049 69.6713 3600.0000
6228 2011-05-03 20:00:00 46.7477 2226.4214 519835 25,9378 959.3143 70.5789 3600.0000
6227 2011-05-03 19:00:00 46.7641 2227.2000 52.0016 25.9692 999.1679 72.2042 3600.0000
6226  2011-05-03 18:00:00 46.7153 2224.8762 51.9474 26.2510 999.4505 74.4571 3600.0000
6225 2011-05-03 17:00:00 4.9573 2238.3340 52.2516 26.6699 999.3701 77.4820 3600.0000
6224 2011-05-03 16:00:00 4.8813 2232.7815 52.1320 26.7217 1000.3629 78.7556 3600.0000
6223 2011-05-03 15:00:00 46.9505 2236.0769 52.2089 25.8858 999.5693 79.8989 3500.0000

6222 2011-05-03 14:00:00 47.0675 22416504 523390 27.3892 998.8147 84.2602 3600.0000
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Figure 5.9—EXxport Data button and dropdown menu

| @@ 516577 Wellé1 Gas 20110504 1632.50f - Scanner Data Manager @
i

File Options Help
=W

@ 5116577 wel#1_Gas_0110504_1632.59F X |G 53100_cComplete (20).sef || 53100_Complete (1).sdf x|

| Device/Meter Name: 5/L16977 Well#1Gas  Dowrloaded on: 2011-05-04 16:31:51
Interval History | Daily History | Configuration | Alarms | Events | Calibrations | Log

Filter?
FEETD Sort Order |Date/Time - Latest First O
print Interval History ~ Fiter by Mont/Day [Nenssdeced ] | StertDete [F1y/2010 :00:00 AN -

Filter by Date Range End Date (5/4/2011 4:00:00 PM -
ustom Bepor Number of Visible Records: 6391

ExportData  ~

Trending

Flow Run 1 Volume

Flow Run 1 Mass |Flow Run 1 Energy |  Differential Static Pressure Process Flow Run 1 Flow
Total Total ress () Temperature Time =]
DegF

Rec Timestamp

2011-05-04 16:00:00

6247 2011-05-04 15:00:00 46.9371 2235.4409 52,1941 26.5809 1001.5825 77.4724 3600.0000

6296 20110504 1400:00 46.9898 2237.9526 52.2527 26.5171 1003.0107 75.686 3600.0000

6245 20110504 13:00:00 46.8455 2231.0806 52.0823 26,2562 998.1213 74,2474 3600.0000

6244 2011-05-04 12:00:00 46.6923 2223.7842 519219 26.1051 1002.2465 73.2984 3600.0000
E 6243 20110504 11:00:00 46,9563 2236.3564 52.2154 26,1445 1003.3030 724243 3600.0000
£247  2011-05-04 10:00:00 46.6075 2219.7422 51.8275 25,6566 1003.3234 71.3988 3600.0000

Email All as Flow-Cal File 11-05-04 09:00:00 46,5837 2218.6113 518011 25,6163 10017228 70,1751 3600.0000
Email All as PGAS File(s) 11-05-04 08:00:00 46.6507 2221.7988 51.8755 25.6263 995.9727 67.5180 3600.0000
11-05-04 07:00:00 46,6747 2222.9434 519025 25,6972 993.0196 66,0992 3600.0000

Email Selected 11-05-04 D6:00:00 46.7501 2226.5344 51.9861 25,6779 993.7145 66.1389 3600.0000
Email XLSX file 11-05-04 05:00:00 46,6152 2220.1077 51.8380 25.6024 992.35886 66.3692 3600.0000
S —— 11-05-04 04:00:00 46,6957 2221.5640 51.8701 25,5100 992.6371 66,4105 3600.0000
11-05-04 03:00:00 4.8325 2230.4583 52.0777 25.8286 992.3243 66,4336 3600.0000

Email PDF File 11-05-04 02:00:00 46.7364 2225.8838 519709 25.7873 991.7548 66.7077 3600.0000
Ernail RTF File 11-05-04 01:00:00 46,5395 2216.5039 51.7519 25,5972 993.0109 67.1638 3600.0000
Ermnail HTML File 11-05-04 00:00:00 4.8530 2231.4338 52,1005 25.8968 993.2314 67,6193 3600.0000
11-05-03 23:00:00 46.6095 2219.8362 51.8297 25.7034 993.8235 68.2496 3600.0000

2011-05-03 22:00:00 46,8863 2233.0210 52,1376 25,9914 996.1383 68.9203 3600.0000

2011-05-03 21:00:00 46,8563 2231.5925 52.1042 25,9387 999,1049 69.6713 3600.0000

2011-05-03 20:00:00 46.7477 2226.4214 51.9835 25,8378 999.8143 70.6789 3600.0000

2011-05-03 19:00:00 46.7641 2227.2000 52.0016 25.9692 999.1679 72.2042 3600.0000

2011-05-03 18:00:00 46,7153 2224.5762 51.9474 26.2510 999,4505 74,4571 3600.0000

2011-05-03 17:00:00 4.9978 2238.3340 52.2516 26,5699 999,3701 77.4820 3600.0000

2011-05-03 16:00:00 46.8813 2232.7815 52.1320 26.7217 1000.3629 78.75586 3600.0000

2011-05-03 15:00:00 46,9505 2236.0769 52.2089 26.8858 99,5693 79.8989 3600.0000

2011-05-03 14:00:00 47.0675 2241.6504 52,3350 27.3842 998.8147 84,2602 3600.0000

Figure 5.10—Email Data button and dropdown menu
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E3 Copy " 1 HighImportance
Paste E Address Check  Attach Aftach Signature Zoom
- < Format Painter BIQ|®-A Book Names | File Hem~ & 4 LowImportance
Clipboard F] Basic Text Names Include Tags 5| Zoom
. | |
|| |
Send
Subject: |P\easerﬂ\mtheseﬂuw(alfl\es
Attached: || 53100 Complete Fi.cfx [0 KB); | | 53100 Complete F2.cfx [9 KB); | | 53100 Complete SL.cfx (4 KB
lix}
-
Device/Meter Name: 53100
Company Name:
Site/Well Name:
Field/Lease Name:
Location Name:
Legal Description:
Downloaded on:  2015-02-20 14:36:48
SDM: 1.0.0 3
Device Ty 5$3100-G1
Firmware: 1.050
Board ID: 0
Device SN: 6291499
Data:
Daily Logs
Interval Logs
Triggered Logs
Alarm Logs
Event Logs -

Figure 5.11—Automated email generated for converted files
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Appendix A—Changing Measurement Units

The data format and units of measurement displayed when a download file is opened in Scanner Data Manager are
based on the configuration of the Scanner flow computer that generated the download file. This appendix describes how
to override the default settings in the download file. To change unit settings or decimal values, click Options>Viewing
Options and click the Scanner device in use in the menu at the left side of the dialog. Settings vary with Scanner mod-
els. Examples of each set of device settings are provided below.

Scanner 3100 Units

From the Scanner 3x00 Viewing Options dialog (Figure A.1), the user can change the unit, rate, decimal position, or for-
mat of a parameter and override the unit in the .sdf file. If a Scanner 3100 archive file contains slave device data, over-
ride selections will apply to the slave device data too.

To change the way a parameter is displayed,
1. Check the Override Units checkbox near the top of the screen to make the unit selections editable.

2. Both US Customary and SI units are provided in the dropdown menu for parameters. However, for added conve-
nience, a user can change the default units, rates, decimals and formats for all parameters to SI or US Customary
by clicking the Sl Units or US Customary button near the top of the screen.

3. Click the cell containing the selection to be changed to open a dropdown menu and make the desired selection.

e Rate selections include per second, per minute, per hour, and per day.
e Up to seven decimal places are available for any unit.
e Parameters can be displayed in fixed point or scientific notation.

4. Click OK. All changes to units will be saved, even if the Override Units checkbox is left unchecked. This allows
the user to switch between units defined in the archive file and the units specified in Scanner Data Manager.

Viewing Options

Viewing Options
-~ General Scanner 3x00 Units
- Scanner 3x00
- Units Unit Categories Defaults
+Seanner 200 Override Units defined in SDF file?
- Units 51 Units US Customary
-Scanner 11xx If overridden use units defined below
i History Settings —
L. Units Category Units Rates Decimals Format =
No Units per second 0.00 Fixed Point n
Uncerrected Gas Volume m? per day Fixed Point
Uncerrected Liquid Volume m? per day :ﬂ Fixed Point
Gas Volume m? per day [T | Fixed Point
Liquid Volume m? per day 0.0000 Fixed Point
Static Pressure (absolute) kPa nfa 0.00000 Fixed Point
0.000000

Static Pressure (gauge) kPa(g) nfa 0.0000000 Fixed Point
Differential Pressure kPa nfa 0.00 Fixed Point
Temperature =C nfa 0.0 Fixed Point
Mass kg per day 0.00 Fixed Point
Energy M3 per day 0.00 Fixed Point
Length mm nfa 0.000 Fixed Point
Frequency Hz nfa 0.0 Fixed Point
Resistance Ohm nfa 0.0 Fixed Point
Current mA nfa 0,000 Fixed Point
Voltage v nfa 0,000 Fixed Point
Fraction nfa 0.00000 Fixed Point I&d

Figure A.17—Scanner 3x00 unit override screen
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Scanner 2x00 Units

Note This dialog pertains to .sdf files downloaded using ModWorX Pro software and to Scanner 2x00 devices in-

stalled as Scanner 3100 slave devices.

From the Scanner 2x00 Viewing Options dialog (Figure A.2), the user can change the unit, rate, decimal position, or cat-
egory of a parameter and override the unit in the .sdf file.

Changing Parameter Displays

To change the way a parameter is displayed,

1.
2.

Check the Override Units checkbox near the top of the screen to make the unit selections editable (Figure A.2).

To change the category for Analog Input 1 or Analog Input 2, click in the “Category” field and selecting the desired
category (Differential Pressure, Static Pressure, Temperature, etc.) from the dropdown list.

To change individual units, click the cell containing the selection to be changed to open a dropdown menu and
make the desired selection.

¢ Units of measure include SI and US Customary selections.
* For the Scanner 2x00, units default to US Customary units.
¢ Rate selections include per second, per minute, per hour, per day, per week, per month, and per year.

To revert back to the factory default units after entering one or more unit changes, the user can restore the default
units for all parameters without leaving the screen. Simply click the Defaults button near the top of the screen to
restore factory default units.

Viewing Options
-~ General Scanner 2x00 Units
Unit Categories
If overridden use units Defadlts
Override Units defined in SDF file?  defined below ik
Name Category Units Decimal
- History Settings Places
- Units Flow Run Volume Flow Run Volume MCF fhour
Flow Run Mass Flow Run Mass LEM 0
0.0
Flow Run Energy Flow Run Energy MMBTU 0.00
Turbine 1 Vol Turbine Vol GAL LELLL
urbine 1 Volume urbine Yolume fhour
Turbine 2 Volume Turbine Volume GAL fhour 0.00000
= 5 0.000000
Static Pressure Static Pressure PSIG 0.0000000
Differential Pressure Differential Pressure InH20 0.0000
Temperature Temperature DegF 0.0000
Analog Input 1 Voltage v 0.0000
Analog Input 2 Voltage v 0.0000
History
Override Dedmal Places | 0.0000 ~

o) [ew )

Figure A.2—Scanner 2x00 unit override screen

4.

5.

Click in the “Decimal Places” field to change the number of decimals displayed for an individual input-related unit
in the Interval or Daily Logs. Up to seven decimal places are available.

Click OK.
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Changing Default Decimal Display
To change all decimal places for every Interval and Daily archive file parameter without changing any other parameters,
1. Uncheck the Override Units checkbox near the top of the screen to disable unit selection editing.

2. Click in the Override Decimal Places dropdown menu (Figure A.3) and select the number of decimal places to
display. Up to seven decimal places are available.

3. Click OK.

=

e Viewing Options

Viewing Options

Viewing Options
- General Scanner 2x00 Units
- Scanner 3x00

e Units Unit Categories

- Scanner 2x00

I overridden use units
[] Override Units defined in SDF file? defined below

History

Override Decimal Places | 0.0000 -

0
0.0

0.00

0.000

0.00000
0.000000

0.0000000

Figure A.3—Scanner 2x00 decimal override selection

Scanner 11xx Units

From the Scanner 11xx Viewing Options dialog, the user can change history settings, such as parameter names, decimal
places, and column width, as well as unit settings, including unit categories, unit, and flow run type settings to custom-
ize the presentation of data in the archive file.

Changing History Settings
To change the way a parameter is displayed in spreadsheets,
1. Select Scanner 11xx>History Settings (Figure A.4, page A-4).

2. Click in the “User Text” field for the desired category and type the name to be displayed. If no user text is entered,
the default category name will appear.

3. Click in the “Decimal Places” field for the desired category and enter the number of decimal places to be displayed.
The default setting is 3.

4. Column width is defaulted to display on spreadsheets. To disable the columnar display for 11xx archive files, un-
check the Show checkbox to the left of “Column Width.”




Appendix A Scanner Data Manager

5. To change the column width, click in the “Column Width” field and enter the desired width. The higher the number,
the wider the column will be.

6. By default, all parameters are enabled to show. To remove a parameter, uncheck the Show checkbox.
7. Click OK.

Viewing Options
Scanner 11xx History Settings
Sfanner et General Spreadsheet
Units
Scanner 11xx Name pis] User Text Decimal Show Column =
| History Settings | Places Width D
- Units Total Volume (Base 03060010 Total Volume 3 114

Total Mass DE040010 Total Mass 3 54

Total Energy 11040010 Total Energy 2 64

Uncorrected Pulse Total 0B020010 Uncorrected Pulse Total 3 (2]

Average Input frequency  0B030010 Average Input frequency 3 64

Differential Pressure 04020010 Differential Pressure = 75

Flow Extension (=sqrt{DP * 02020010 Flow Extension 3 64

Flowing Pressure 01030010 Flowing Pressure 3 90

Live Temperature 01020010 Live Temperature 3 90

Real Gas Relative density 07010010 Real Gas Relative density 3 95

Fluid Density at flowing 06010010 Fluid Density at flowing 2 64

Volumetric Heating value 10010010 Volumetric Heating value 3 90

Meter factor (interpolated) 04110010 Meter factor 3 654

Base Solids and Water 2D010010 Base Solids and Water = 54

Peak Pressure (hourly) 45010010 Peak Pressure 3 64

Peak Volume Flow Rate 45030010 Peak Volume Flow Rate 3 64

Hourly Flowtime FFB0O0010 Flowtime 3 54

Input 1 03040010 Input1 3 &6
Input 2 03050010 Input2 3 7l 64 56

x ]

Figure A.4—Scanner 11xx history settings

Changing Units Settings
To change the way units are displayed
1. Select Scanner 11xx>Units.

2. Click in the appropriate field in the “History” area or the “Configuration” area (Figure A.5, page A-5) and select
the unit in which the archive file data will be viewed from the dropdown list.

Note The Gas, Liquid, and Monitor columns refer to the flow run type defined in the archive file.

3. The “Default Units” area of the screen should be used when the flow run type is not stored in the archive file. To
change the default units, click the dropdown area next to a flowrun and select gas, monitor, or liquid for that flow
run.

4. Click OK.
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History Configuration
Name Gas Liquid Monitor <] [category Units -
Total Volume (Base E3M3 E3M3 E3M3 E‘ Temperature c D‘
- History Settings Total Mass ka ka ka Volume E3M3
) Total Energy G1 Gl Gl Distance mm
Uncorrected Pulse Total E3M3 E3M3 E3M3 Static Pressure (abs) kPaa
Average Input frequency Hz Hz Hz Differential Pressure kPa
Differential Pressure kPa kPa kPa Energy G1
Flow Extension (=sqrt(DP Mass ka
Flowing Pressure kPaa kPaa kPaa Density kgM3
Live Temperature C c c Time s
Real Gas Relative density RDg RDg RDg Current A
Fluid Density at flowing kaM3 kaM3 kg/M3 Voltage v
Volumetric Heating value MIM3 MIM3 MIM3 Absolute Viscosity e
Meter factor (i Percent N2 %o -
Default Units
Flowrun #1 E Flowrun #4 Flowrun #7 Flowrun #10 Flowrun #13 |Gas
Flowrun #2 Flowrun #5 Flowrun #3 Flowrun #11 Flowrun #14 |Gas
Flowrun #3 \l\gﬂ:j Flowrun #5 Flowrun #9 Flowrun #12 Flowrun #15
Note:
These are the default type of units used when configuration isn't included within the SCM fila.

Figure A.5—Scanner 11xx unit selections
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Appendix B

Appendix B—Technical Support

Help Menu

The Help>About menu provides access to the Scanner Data Manager User Manual, phone and email contact informa-
tion for regional Cameron offices, and a link for sending files to the nearest regional office.

Send File to Cameron

In the event that you need the help of a technician, Cameron provides a built-in email tool to help expedite the trouble-

shooting process.

1. Select Help>Send File to Cameron Office (Figure B.1) and select the regional office nearest you from the drop-
down list provided. A new email window will open with the data file and the associated log file attached and the
email address of the selected office pre-entered. If you know the email address of your primary Cameron contact,
click on “Custom - Enter Contact” in the dropdown menu and enter the email address in the email window.

2. Enter additional notes in the body of the email if desired and click Send.

Help

@ About

¢ Manual

[E Send File to Cameron Office »

Figure B.1—Help menu

United States

Canada

Latin America
Europe/Russia/5ub-5aharan Africa
Asia Pacific

Middle East/Morth Africa

India

< Custom - Enter Contact>

CAUTION

Scanner 3100 archive file (.sdf) sizes may exceed 30 MB. If your email host restricts the size of

attachments, compress (zip) the archive file and reattach to the email before sending or contact
Cameron for assistance. Scanner 2x00 and 11xx typically do not exceed 1.5 MB and many are

smaller than 500 KB.

Technical Contacts

For phone numbers and email addresses for regional Cameron offices, select Help>About and click Technical

Support.
L About Scanner Data Manager
Copyright & Cameron 2012 - 2015
Scanner® Data Manager
Scanner is a registered trademark of Cameron
International Corporation {Cameron)
[ Technical Support ]
[ License Agreement ]
@ CA M E R 0 N Measurement Systems

Technical Support

P

Far technical support, contact the support center nearest you:

Canada
1.403.291.6251
ms-canada@c-a-m.com

United States
1.800.654.3760 (toll-free)
ms-us@c-a-m.com

Latin America
1.403.291.5890
ms-atinamerica@c-a-m. com

Europe, Caspian, Russia, Asia Pacific
and Sub-Saharan Africa 50.3.7954.0145
44.1892. 518000 ms-+kl@c-a-m.com
ms-ukiEc-a-m.com

India

91.982.2431686

ms-ind@c-a-m.com

www.c-3-m.com/flo

Figure B.2—About Scanner Data Manager and Technical Support screens

Middle East and
North Africa

971.4802.7700
ms-me@c-a-m.com
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WARRANTY - LIMITATION OF LIABILITY: Seller warrants only title to the products,
software, supplies and materials and that, except as to software, the same are free from
defects in workmanship and materials for a period of one (1) year from the date of delivery.
Seller does not warranty that software is free from error or that software will run in an un-
interrupted fashion. Seller provides all software “as is”. THERE ARE NO WARRANTIES,
EXPRESS OR IMPLIED, OF MERCHANTABILITY, FITNESS OR OTHERWISE WHICH
EXTEND BEYOND THOSE STATED IN THE IMMEDIATELY PRECEDING SENTENCE.
Seller’s liability and Buyer’s exclusive remedy in any case of action (whether in contract, tort,
breach of warranty or otherwise) arising out of the sale or use of any products, software,
supplies, or materials is expressly limited to the replacement of such products, software,
supplies, or materials on their return to Seller or, at Seller’s option, to the allowance to the
customer of credit for the cost of such items. In no event shall Seller be liable for special,
incidental, indirect, punitive or consequential damages. Seller does not warrant in any way
products, software, supplies and materials not manufactured by Seller, and such will be
sold only with the warranties that are given by the manufacturer thereof. Seller will pass
only through to its purchaser of such items the warranty granted to it by the manufacturer.




MEASUREMENT SYSTEMS

HEADQUARTERS (HOUSTON, TX) ASIA PACIFIC CANADA EUROPE, CASPIAN, RUSSIA & S. AFRICA

1.281.582.9500 +603.7954.0145 1.403.291.4814 +44.1892.518000
ms-kl@c-a-m.com ms-canada@c-a-m.com ms-uk@c-a-m.com

INDIA LATIN AMERICA MIDDLE EAST & NORTH AFRICA UNITED STATES

91.982.2431686 +55.21.2172.9714 971.4802.7700 1.800.654-3760

ms-ind@c-a-m.com ms-latinamerica@c-a-m.com ms-me@c-a-m.com ms-us@c-a-m.com

WWW.c-a-m.com/measurement @CAMERON
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